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RACUNALOM PODRZANO OBLIKOVANJE

1. UvOD

AutoCAD je racunalni program tvrtke Autodesk, koji podrzava crtanje u dvije (2D) ili tri
(3D) dimenzije.

CAD (engl. Computer Aided Design) definiran je kao racunalom podrzano oblikovanje.

AutoCAD je pronaSao vrlo Siroku primjenu u inZenjerstvu (strojarstvo, gradevinarstvo,
geodezija, elektro i dr. tehnicke struke) zbog svoje prilagodljivosti i sveobuhvatnosti sto ga
¢ini pristupa¢nim za upotrebu.

AutoCAD omogucuje sve faze projektiranja, od 2D crtanja do 3D modeliranja i vizualizacije
za sva inzenjerska podrucja, s mogucénoscu nadogradnje specificnim aplikacijama koje
dodatno olaksavaju i ubrzavaju rad.

1.1. POKRETANJE PROGRAMA

AutoCAD se pokrece na jedan od sljedecih nacina:

- iz izbornika Start = All Programs - Autodesk = AutoCAD... (slika 1.1)

Autodesk
» A360 Desktop
A Uninstall Tool
AutoCAD 2016 - English
L Attach Digital Signatures
& AutoCAD 2016 - English
i Batch Standards Checker
A\ License Transfer Utility - AutoCA

[

i Reference Manager

. Autodesk ) Autodesk
o b > o pescon B o o
A Uninstall Tool A Uninstall Toal . Autodesk Application Manager -
| AutoCAD 2016 - English - AutoCAD 2016 - English 4 Back
> AllPrograms J Autodesk Application Manager Autodesk Application Manager
I B 51 | Autodesk ReCap 2016 , Autodesk ReCap 2016 [ Search programs and fites ol
B | Content Service . Content Service

Slika 1.1. Pokretanje programa AutoCAD 2016

. . . P o CAD
- dvoklikom na ikonu programa na radnoj povrini B .

1.2. GRAFICKO KORISNICKO SUCELJE AutoCAD-a 2016

Graficki prozor programa AutoCAD moze se podijeliti na sljedeca podrucja (slika 1.2):

e Traka s nazivom i aktivnom datotekom (Title Bar)

e Traka padajuéih izbornika (Menu Bar) — padaju¢i izbornik s dostupnim naredbama

e Alatne trake (Toolbars) — npr. Draw, Modify...
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RACUNALOM PODRZANO OBLIKOVANJE

o Plutajuce alatne trake (desnim klikom na neku od alatnih traka mozemo na radnu
povrsinu ,,izvuéi® alatnu traku s ikonama naredaba koje cesto upotrebljavamo,
npr. alatna traka Draw s pripadaju¢im naredbama (Line, Circle, Polygon ...)

_ [ L=
Traka padajucih izbornika

Aktivni prozor — povrsina za crtanje

L ]
-
o
.
~
-
»
L
L3
-
=
o]
L]
A

Naredbeni redak Statusna traka i pomo¢ne funkcije

MODEL |

Slika 1.2. Grafi¢ko korisni¢ko suéelje AutoCAD-a 2016

e Povrsina za crtanje — Radna povrsina (engl. Drawing Area)

Pozadina radne povrSine u AutoCAD-u po defaultu je crna, medutim ona je promjenjiva pa
tako ¢esto mozemo vidjeti da se upotrebljava i bijela (iako su dostupne i sve ostale boje u
rasponu od 0 do 255). Postavljanje boje radne povrSine moze se ostvariti odabirom Tools na
izbornoj traci te odabirom sljede¢ih kartica (Tools = Options - Display - Color),
prikazano na slici 1.3.

e lkona koordinatnog sustava:
o Globalni — WCS (World Coordinate System)
o Lokalni — UCS (User Coordinate System)

¢ Graficki pokaziva¢

[]

PRILIKOM UNOSA PRILIKOM ODABIRA
STANDARDNI KOORDINATA TOCKE OBJEKTA

Danijela Pezer, pred.



RACUNALOM PODRZANO OBLIKOVANJE

Tools

Workspaces 3
Palettes 3
Toolbars 3
[= Command Line Ctrl+9
Clean Screen Ctrl+0
aBg Cumertt profile: <<Unnamed Profile>> & Cument drawing: leutevi.dwg
"% Spelling P
4% Quick Select... Display | Open and Save | Plot and Publish | System | User Prefersnces | Drafting | 3D Modeiing | Selection | Profiles | Oriins |
Draw Order > Window Elements s Drawing Window Colors
» -
s Color scheme: | Dark Context: Interface element: Color:
Inquiry > -
o Disgl 1 bars in d d Sheet / layout Crossharrs
= UpdateFields [E] Display serol bar n dreving windonw 30 parallel projection Viewport control M Red
. [] Use large buttons for Toolbars 3D perspective projection Grid major lines O vellow
s P ‘ 1
5| Block Editar Resize ribbon icons to standard sizes E‘Sﬁ:ﬂz‘:ﬁm g;:a ;")';‘:HQ:S £ E Green
Xref and Block In-place Editing > Show ToolTips Plot preview Autotrack vector ] E.ﬁi”
= 2d Autosnap marker
Data Extraction... Shaw shorteut keys in ToolTips u Aumsnag marker W Magenta
Data Links v Show extended Tool Tips g!‘”;m‘ii‘mlﬁgs'c'" lines u|
rarting too’ tip Black
Action Recarder [ 2 ] Narberef seondatadely Dmffgng m: o Ewdzur d = 33,40,48
Drafting tool tip backgroun S
B Show rollover ToolTips Control vertices hull 8 select Color...
Load Application... Display Fils Tabs Light glyphs o
W ronscrpe..
Top][X-ray]
Macra » [+[Top y
Layout elements
AutolISP 4 Display Layout and Modsl tabs
7
Display Image b Display printable area
Display paper background
New UCS ' Display paper shadow
L2 Named UCS... [ Show Page Setup Manager for new layouts
[¥] Create viewport in new layouts
@ Geographic Location...
CAD Standards 3
Wizards 3
Iy Drafting Settings...
& Group [ appyscose || caneel | [ Heb
9 Ungroup
Tablet 3
Customize 3
@ Options...

Slika 1.3. Promjena pozadine radne povrsine u AutoCAD-uU

e Skupine naredaba — Palete (Palettes)
e Kartice okruZenja prostora i listova (Tabs)
e Okvir naredbenog retka (Command Line Frame) — sluzi za unos naredaba

e Statusna traka (Status Bar) — prikazuje aktivne naredbe

-> ukljucene naredbe oznacene plavom bojom, isklju¢ene naredbe prikazane sivo
(SNAP, GRID, ORTHO, POLAR, OSNAP, OTRACK, DUCS, DYN, LWT...)

SNAP (Snap) — korak (moguce ukljuciti i funkcijskom tipkom F9)

GRID (Grid) — mreza (moguce ukljuciti i funkcijskom tipkom F7)

ORTHO - pravokutno (ortogonalno) crtanje (moguce ukljugiti i funkcijskom tipkom F8)
POLAR (Polar Tracking) — polarno pracenje (moguce ukljuciti i funkcijskom tipkom F10)
OSNAP (Object Snap) — aktivni niSani (moguce ukljuciti i funkcijskom tipkom F3)
OTRACK (Auto Track) — automatsko prac¢enje objekata

DUCS (Dynamic UCS) — dinami¢ni koordinatni sustavi

LWT (Display Linewight) — prikaz Sirine linija
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1.3. RAD S RACUNALNIM MISEM

srednja tipka Lijeva tipka: - odabir stavke
{kotacic) - zadavanje tocke
lijeva desna - zadrzati lijevi klik = Lasso
tipka tipka

Srednja tipka: pomicanje prikaza (Pan) ili plutajuci izbornik
niSana

Desna tipka (promjenjiva): plutajuéi izbornik (moze se definirati
odabirom Tools - Options - Preferences)

Kotaci¢: uvecanje (Zoom) ili smanjenje prikaza

1.4. NAREDBE

Naredbu je moguce pozvati na vise nacina:

unosom naredbe u ovir naredbenog retka

iz padajuceg izbornika

odabirom ikone s alatne trake

ponavljanjem posljednje izvrSene naredbe (ENTER)
desni klik misa (Repeat IME _NAREDBE)

Naredba zavr$ava tipkom ENTER ili desnim klikom misa.
Prekidanje naredbe izvrSava se tipkom ESC.

Ponistavanje naredbe:

Edit > UNDO
odabirom ikone kal koja se nalazi na traci za brzi pristup Cesto koriStenih naredaba

D ks e

unosom kratice U (ENTER) u naredbeni redak
kombinacijom tipki Ctrl + Z

Vracanje naredbe:
e Edit > REDO

e odabirom ikone &t koja se nalazi na traci za brzi pristup ¢esto koristenih naredaba

bhedBoa &

Opcije naredaba:

e Unos kratice naredbe = uobicajeno prvo slovo naredbe ili vise slova (npr. naredba
LINE)

e <> pretpostavljena opcija koju potvrdujemo s ENTER

Danijela Pezer, pred.
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1.5. OSNOVE RADA U AutoCAD-u
Kreiranje, pohranjivanje i odabir postojeceg crteza

Kreiranje novog crteza: Odabirom File = New otvara se dijaloski okvir za odabir predloska
(slika 1.4) za crtanje sadrzan unutar programa AutoCAD. Predlo$ci su pohranjeni u mapi
Template, a najéesée koristeni AutoCAD-ov predlozak jest acad.dwt (datoteka s ekstenzijom
*.dwt).

Prilikom kreiranja novog crteza korisniku je omoguceno i kreiranje vlastitih predlozaka.

Lock in: l . Template 'J

Mame
31 | PTWTemplates

J SheetSets
5 acad—Named Plot Styles
- [ acad -Named Plot Styles3D
acad
acad3D
Bl acadISO -Named Plot Styles
[y acadIS0 -MNamed Plot Styles3D
acadiso
ﬂ“\ acadiISDBF]
Tutorlal—lArch

It

. bl Tutorial-ibdfg

\J éﬁ Tutorial-mArch
L

TutDriaI—meg

\p'? File name: acad|

Files of type: [Dlawing Template (" dwt)

Slika 1.4. Predlosci u AutoCAD-u

Pohranjivanje crteza

Naredba QSAVE - padajuéi izbornik File > Save (Ctrl+S) ili gumb &l sluzi za
pohranjivanje promjena u aktivnu datoteku. Ako datoteka nije imenovana, pojavljuje se
dijalog za unos imena i odabir mape, odnosno mjesta pohranjivanja.

Naredba SAVEAS — padajuéi izbornik File = Save As ili gumb & sluzi za pohranjivanje
promjena ve¢ imenovane datoteke, ali pod drugim imenom. Nastaju dva zapisa, odnosno dvije
datoteke; stara i novoimenovana.

Preporuka je da se prilikom pohranjivanja datoteka ne koriste dijakriticki znakovi hrvatskog
jezika (¢, €, d, §, Z), razmaci niti drugi specijalni znakovi poput /,.;: i dr., dok je dopusteno
koriStenje crtice odnosno donje crte: —i _.

Prilikom pohranjivanja crteza u AutoCAD-u imenu datoteke automatski se dodjeljuje
ekstenzija *.dwg.

Danijela Pezer, pred.
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Odabir postojeceg crteza: Izbornikom File = Open otvara se dijaloski okvir Select File
preko kojeg odabiremo i otvaramo traZzenu datoteku.

Izlazak iz AutoCAD-a: Izbornik File - Exit (Ctrl+Q) ili Alt+F4 ili gumb @ .

1.6. KOORDINATNI SUSTAVI

U programskom paketu AutoCAD postoje dva koordinatna sustava: globalni — WCS (World
Coordinate System) i lokalni — UCS (User Coordinate System).

Unutar koordinatnog sustava koordinate tocke mogu se zadati na viSe nacina, prema
matematickoj podjeli koordinatnih sustava.

Kooordinatni sustavi u prostoru:
e Kartezijev koordinatni sustav (X, Y, z)
¢ Cilindri¢ni koordinatni sustav (0, ¢, z)

o Sferni koordinatni sustav (r, ¢, ©).

Koordinatni sustavi u ravnini:
e Pravokutni koordinatni sustav (X, y): unos X,y
e Polarni koordinatni sustav (r, ¢): unos r<q.

A

y
(x.y)
>
Pravokutni koordinatni sustav Polarni koordinatni sustav

Kod pravokutnog koordinatnog sustava polozaj tocke odreduje se udaljenoscu od ishodista po
X 1y osi. Kod polarnog koordinatnog sustava polozaj to¢ke odreduje se udaljeno$¢u od
ishodista i kutom u odnosu na os X.

Kutovi pri definiranju polarnih koordinata:
30°

135° 45°

180° 0°

225 315°

270°

U AutoCAD-u koordinate se mogu unositi kao apsolutne i relativne.

Danijela Pezer, pred.
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Apsolutnim koordinatama polozaj tocke odreduje se (u odnosu na UCS) unosom X iy
koordinata odvojenih zarezom: x,y (npr. 50,50).

Relativnim koordinatama odreduje Se polozaj neke tocke u odnosu na posljednju ucrtanu
odnosno izabranu toc¢ku. Ispred relativnih koordinata obvezno se upisuje sljede¢i kontrolni
znak: @x,y (npr. @50,50), odnosno X,y uz uklju¢enu opciju Dynamic Input (DYN).

1.7. OSVJEZIVANIE PRIKAZA

View - Redraw
- Regen
-> Regen All

Precrtavanje REDRAW — osvjezuje prikaz, odnosno uklanja zaostalo smece (primjer krizica
BLIPMODE).

Preracunavanje REGEN — osvjezuje prozor crteza i ponovno preratunava sve objekte na
crtezu. PoboljSava preciznost prikaza (primjer kruznice koja uvecana izgleda poput
visekutnika).

Naredba REGEN OBVEZNO se koristi kod promjene svojstava slojeva (Layer).

1.8. UPRAVLJANJE PRIKAZOM - namijestanje pogleda

View = Zoom
- Pan

Naredbe PAN i ZOOM omogucuju pregled dijelova crteza i u tijeku crtanja (transparentne
naredbe). Dostupne su i na standardnoj alatnoj traci i na statusnoj traci.

Pomicanje PAN — pozivanje naredbom ili srednjom tipkom misa (zadrzati srednju tipku misa
— pokaziva¢ misa u obliku je rucice).

Uvecanje/smanjenje ZOOM — pozivanje naredbom ili kotaci¢em na misSu (uvecanje prikaza

okretanjem kotaci¢a miSa prema naprijed, smanjenje prikaza okretanjem kota¢i¢a miSa prema

sebi).

1.9. POSTAVLJANJE GRANICA CRTEZA U AutoCAD-u

AKko zelimo postaviti granicu crteza, primjerice na format papira A4 dimenzija 210 x 297 mm
— okomito (portrait) ili 297 x 210 mm — vodoravno (landscape), potrebno je u naredbenom
retku (Command line) pozvati naredbu LIMITS, zatim potvrditi tipkom ENTER.

Sljedeci je korak unos dimenzija, npr. 210,297.

Nakon toga potvrda tipkom ENTER.

Danijela Pezer, pred.
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Uz ukljucenje naredbe GRID — mreza (gumb na statusnoj traci) omogucen je pogled na
veli¢inu granice crteza (Slika 1.5). Ako granica nije vidljiva, potrebno je pozvati naredbu
ZOOM - podopcija Extents.

Slika 1.5. Postavljanje granice crteza — pogled u Layoutu

Postavljanje granica crteza sluzi nam kao orijentacija kako bismo prilikom crtanja vodili
rauna o ispisu, odnosno da nam svi nacrtani elementi budu vidljivi prilikom ispisa.
Postavljanje granice crteza nije nuzno definirati, odluka je na samom korisniku.

Postavke je moguce definirati preko STARTUP dijaloskog prozora (ako je aktivan) ili
naknadno.

Pozivom naredbe STARTUP i potvrde tipkom ENTER pruza nam se moguénost izbora da se
prilikom svakog pokretanja AutoCAD-a otvara dijaloski prozor STARTUP preko kojeg je
omoguéeno korak po korak definiranje postavaka (parametara). Ako je preddefinirana
vrijednost nula (0), startni prozor je iskljucen, ako je postavljen na jedan (1), startni prozor je
ukljucen.
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Definiranje mjernih jedinica u kojima crtamo crtez. U strojarstvu sve Su izmjere u
milimetrima, stoga je u postavkama (Format = Units pri ¢emu se otvara dijalog Drawing

Units) potrebno definirati jedinice (Units) u milimetrima (Milimeters).

Danijela Pezer, pred.
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Slika 1.6. Definiranje mjernih jedinica
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2. KREIRANJE OBJEKATA

AutoCAD omogucuje kreiranje jednostavnih objekata (tocka, linija, kruznica), ali isto tako i
slozenih objekata.
Otvaranjem padajuceg izbornika Draw ili istoimene alatne trake

no je kreiranje objekata.

2.1. TOCKA ’
/ Line
/" Ray
Naredba POINT (Draw = Point - Single Point ° ) omoguéuje crtanje [ Crorntne
toCaka. .
v . e1e . « . ot Polyline
Tocka se crta unosom koordinata ili proizvoljnim odabirom u prostoru. 2y 3D Polyline
S obzirom na to da tocka (.) nije jasno vidljiva na ekranu, mozemo |O Pobgen
promijeniti (Format = Point Style...) izgled prikaza to¢ke iz simbola (.) % resene
u npr. simbol (x) — slika 2.1. e R
?— Circle 3
ayer..
% Layer States Manager... @ Donut
Layer tools » Spline 3
@ Color.. Ellipse 4
L Block »
Lineweight...
Transparency E Table...
Ji Scale List... Point 4
As TetStyle. &} Hatch...
A Dimension Style... - ! H Gradient...
A e[| It Boundary.
Plot Style... @ @ [y Region
[# PointStyle.. @ @ ﬁ Wipeout
> Multline Style... £ Revision Cloud
L] | s Port See- 50000 x Port Sze: 50000 2 Text »
€7 Thickness
L Drawing Limt I—'I> Koo ,—D s
[T Rename... oK J[Ccmed [ ] Hep

Slika 2.1. Promjena prikaza to¢ke u AutoCAD-u

Potrebno je definirati tocku odabirom u radnom prostoru ili unosom koordinata tocke:

POINT Specify a point:

zatim potvrditi tipkom ENTER.

2.2. LINNA

Naredba LINE (Draw > Line ) omogucuje crtanje linija. Potrebno je definirati pocetnu
toc¢ku (Specify first point) odabirom u radnom prostoru ili unosom koordinata tocke:

LINE Specify first point:
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Zatim je potrebno definirati drugu tocku (Specify next point or [Undo]):

LINE Specify next point or [Undo]:

e ENTER ili ESC na tipkovnici zavrSava crtanje linija

e UNDO ili Ctrl+Z ponistava prethodnu liniju

e CLOSE (C+ENTER) spaja prvu tocku prve linije sa zadnjom to¢kom posljednje linije
zadane istom naredbom.

2.3. PRAVOKUTNIK

Naredba RECTANG (Draw > Rectangle =) omogucuje crtanje pravokutnika.
Potrebno je definirati prvu tocku kuta pravokutnika ili jednu od ponudenih opcija:

Chamfer — skosenje vrhova pravokutnika na zadane udaljenosti
Elevation — uzdignuée od XY ravnine za sljedece pravokutnike
Fillet — zaobljenje vrhova uz zadavanje polumjera

Thickness — prostorna debljina za sljedece pravokutnike

Width — §irina polilinije za sljedece pravokutnike

RECTANG Specify first corner point or [Chamfer Elevation Fillet Thickness \Width]:

Zatim je potrebno definirati drugu to¢ku kuta pravokutnika, u pravilu relativnim
koordinatama (slika 2.2) ili zadati dimenzije (Dimensions) stranica:

RECTANG Specify other corner point or [Area Dimension Rotation]: Dimension

Ako smo odabrali opciju definiranja dimenzija, sljede¢i je korak definiranje duljine
pravokutnika:

RECTANG Specify length for rectangles <10.0000>: 210

Zatim je potrebno definirati Sirinu pravokutnika:

RECTANG Specify width for rectangles <10.0000>: 297

Primjer zadavanja toc¢aka (1 i 2) pravokutnika (relativnim koordinatama) s dimenzijama A4
formata papira dan je naslici 2.2.
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2@

[

10,297

A4

1

Slika 2.2. Zadavanje to¢aka (1 i 2) relativnim koordinatama

2.4. VISEKUTNIK (POLIGON)

Naredba POLYGON (Draw = Polygon Cﬁ") omogucuje crtanje visekutnika.

Dvije su mogucénosti crtanja visekutnika (slika 2.3):

e viSekutnik upisan u kruznicu (Inscribed in circle)
e visekutnik opisan oko kruznice (Circumscribed about circle).

Upisan u kruznicu Opisan oko kruZnice

Slika 2.3. Crtanje visekutnika

Prilikom crtanja viSekutnika potrebno je definirati broj stranica, npr. 5:

POLYGON_polygon Enter number of sides <4>:5

Zatim je potrebno zadati sredisSte crtanja visekutnika (predstavlja srediste kruznice oko koje ¢e
viSekutnik biti opisan ili upisan) ili stranicu viSekutnika [Edge], pri ¢emu je bitan smjer

zadavanja stranica:
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POLYGON Specify center of polygon or [Edge]:

Sljedeci je korak odabir izmedu opcija: visekutnik opisan oko kruznice ili upisan u kruznicu:

POLYGON Enter an option [Inscribed in circle Circumscribed about circle] <I>: ENTER

Posljednji je korak zadavanje radijusa kruznice:

POLYGON Specify radius of circle:

Nakon definiranog radijusa naredbu zavr§avamo tipkom ENTER.

2.5. KRUZNI LUK

Naredba ARC (Draw = Arc = ... /) omogucuje crtanje kruznog luka na vise nacina:

e crtanje kruznog luka zadavanjem triju tocaka £ 3Points

Definiranjem pocetne tocke luka:

ARC Specify start point of arc or [Center]:

Definiranjem druge tocke luka:

ARC Specify second point of arc or [Center End]:

Definiranjem krajnje tocke luka:

ARC Specify end point of arc:

e crtanje kruznog luka zadavanjem pocetne toCke, prolazne tocke i1 krajnje tocke
f: Start, Center, End

Definiranjem pocetne tocke luka:

ARC Specify start point of arc or [Center]:

Definiranjem prolazne tocke (sredista) luka:
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ARC Specify center point of arc :

Definiranjem krajnje tocke luka:

ARC Specify end point of arc (hold Ctrl to switch direction) or [/Angle chord Length]:

e crtanje kruznog luka zadavanjem pocetne tocke, prolazne tocke i uklju¢nog kuta luka
_'{':’: Start, Center, Angle

Definiranjem pocetne tocke luka:

ARC Specify start point of arc or [Center]:

Definiranjem prolazne tocke (sredista) luka:

ARC Specify center point of arc:

Definiranjem uklju¢nog kuta luka:

ARC Specify included angle (hold Ctrl to switch direction):

Kut se mjeri od osi X trenuta¢nog koordinatnog sustava u pozitivnom matemati¢kom
smjeru (suprotno od kretanja kazaljke na satu). Ako mjerimo u negativhom smijeru,
kutu je potrebno dodati negativni predznak, odnosno minus (-).

e crtanje kruznog luka zadavanjem pocetne tocke, prolazne tocke i1 duljine tetive luka
;_’?Z Start, Center, Length

Definiranjem pocetne tocke luka:

ARC Specify start point of arc or [Center]:

Definiranjem prolazne tocke (sredista) luka:

ARC Specify center point of arc:

Definiranjem duljine tetive luka:

ARC Specify lenght of chord (hold Ctrl to switch direction):
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e crtanje kruznog luka zadavanjem pocetne tocke, krajnje tocke i uklju¢nog kuta luka
_;_"?ﬂ Start, End, Angle

Definiranjem pocetne tocke luka:

ARC Specify start point of arc or [Center]:

Definiranjem krajnje tocke luka:

ARC Specify end point of arc:

Definiranjem uklju¢nog kuta luka:

ARC Specify included angle (hold Ctrl to switch direction):

e crtanje kruznog luka zadavanjem pocetne tocke, krajnje tocke 1 nagiba tangente luka u

pocetnoj tocki (pri cemu nije bitan smjer zadavanja tocaka) e

Definiranjem pocetne tocke luka:

ARC Specify start point of arc or [Center]:

Definiranjem krajnje tocke luka:

ARC Specify end point of arc:

Definiranjem nagiba tangente luka:

ARC Specify tangent direction for the start point of arc (hold Ctrl to switch direction):

e crtanje kruznog luka zadavanjem pogetne tocke, krajnje tocke i polumjera kruznog
luka ﬂ Start, End, Radius

Definiranjem pocetne tocke luka:

ARC Specify start point of arc or [Center]:

Definiranjem krajnje tocke luka:

ARC Specify end point of arc:

Definiranjem polumjera kruznog luka:
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ARC Specify radius of arc (hold Ctrl to switch direction):

Smjer zadavanja pocetne i krajnje tocke odreduje izgled luka u pozitivnom
matematickom smjeru.

Sljedece tri opcije zapravo su identi¢ne drugoj, trecoj i Cetvrtoj toc¢ki, samo obrnutog
redoslijeda zadavanja tocaka:

e crtanje kruznog luka zadavanjem prolazne tocke, pocetne tocke i krajnje tocke
{: Center, 5tart, End

e crtanje kruznog luka zadavanjem prolazne tocke, pocetne tocke 1 ukljucnog kuta luka
d/'/: Center, Start, Angle

e crtanje kruznog luka zadavanjem prolazne tocke, pocetne tocke i duljine tetive luka
;ffi Center, Start, Length

Posljednja opcija crtanja kruznog luka jest opcija Continue.

e opcija Continue omogucuje nastavak crtanja kruznog luka tangentno na prethodni luk
ili liniju, na nacin da se na opciju unosa prve tocke luka potvrdi tipkom ENTER

{Lﬂ Continue

ARC Specify end point of arc (hold Ctrl to switch direction):

2.6. KRUZNICA
Naredba CIRCLE (Draw = Circle © ... @) omoguéuje crtanje kruznice na vide nagina:

e crtanje kruznice zadavanjem sredista i polumjera (& Center, Radius

Definiranjem srediSta kruZnice:

CIRCLE Specify center point for circle or [3P 2P Ttr (tan tan radius)]:

Definiranjem polumjera (radijusa) kruznice:
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CIRCLE Specify radius of circle or [Diameter]:

. . . . o . (#) Center, Diameter
e crtanje kruznice zadavanjem sredista i promjera @ '

Definiranjem sredista kruznice:

CIRCLE Specify center point for circle or [3P 2P Ttr (tan tan radius)]:

Definiranjem promjera kruznice unosom promjera:

CIRCLE Specify radius of circle or [Diameter] <15.0000>: _d Specify diameter of
circle <30.000>:

e 2P — kruznice zadavanjem dviju tocaka O  2Points

Definiranjem prve to€ke (1) kruznice:

CIRCLE Specify center point for circle or [3P 2P Ttr (tan tan radius)]: _2p Specify first
end point of circle's diameter:

Definiranjem druge tocke (2) kruZnice:

CIRCLE Specify second end point of circle's diameter:

e 3P — crtanje kruznice zadavanjem triju to¢aka (> 3 Points

Danijela Pezer, pred.



RACUNALOM PODRZANO OBLIKOVANJE

Definiranjem prve tocke (1) kruznice:

CIRCLE Specify center point for circle or [3P 2P Ttr (tan tan radius)]: _3p Specify first
point on circle:

Definiranjem druge tocke (2) kruznice:

CIRCLE Specify second point on circle:

Definiranjem trece tocke (3) kruznice:

CIRCLE Specify third point on circle:

e TTR — crtanje kruznice zadavanjem dvaju objekata (kruznica, luk ili linija) na koje je

kruznica tangentna, te polumjer kruznice @} Tan, Tan, Radius

Definiranjem tocke na objektu (trokutu) kao prva tangenta na kruznicu:

CIRCLE Specify point on object for first tangent of circle:

Definiranjem tocke na objektu (trokutu) kao druga tangenta na kruznicu:

CIRCLE Specify point on object for second tangent of circle:

Definiranjem polumjera kruZnice:

CIRCLE Specify radius of circle <115.10388> :

e TTT — crtanje kruznice zadavanjem triju objekata (kruznica, luk ili linija) na koje je
kruznica tangentna {2t Tan, Tan, Tan
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Definiranjem prve tocke na objektu (trokutu) na koju je kruznica tangentna:

CIRCLE Specify center point for circle or [3P 2P Ttr (tan tan radius)]: _3p Specify first
point on circle: _tan to

Definiranjem druge tocke na objektu (trokutu) na koju je kruznica tangentna:

CIRCLE Specify second point on circle: _tan to

Definiranjem trece tocke na objektu (trokutu) na koju je kruznica tangentna:

CIRCLE Specify third point on circle: _tan to

2.7. POLILINNA

Naredba PLINE (Draw =>» Polyline =) omoguéuje crtanje polilinije (pojedinacni objekt
spojen nizovima linija i kruznih lukova).

Naredba PLINE omogucuje:
e crtanje linija (Line)
e crtanje lukova (Arc).

Pri prvom koraku crtanja polilinije odabire se pocetna tocka (Specify start point):

PLINE Specify start point:

Sljedeci je korak definiranje druge tocke (Specify next point or [Arc Halfwidth Lenght Undo
Width]) ako se radi o liniji, ili mozemo nastaviti crtanje luka odabirom Arc (potrebno
definirati kut). Naredba omoguéuje naizmjeni¢no crtanje linija i lukova po potrebi:

PLINE Specify next point or [Arc Halfwidth [ength Undo \Width]:

Width/Halfwidth — odredivanje Sirine odnosno pola Sirine dijelova polilinije. Zadaje se Sirina
na pocetku 1 na kraju segmenta. Sirina na kraju ostaje Sirina sljede¢eg segmenta.
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Lenght — crtanje segmenta linije zadane duzine s jednakim nagibom kao u prethodnom
segmentu. Ako je prethodni segment luk, segment se nastavlja tangentno na luk:

PLINE Specify next point or [Arc Close Halfwidth [ength Undo \Width]:

Opcija Close spaja pocetak i kraj polilinije.

2.8. ELIPSA

Naredba ELLIPSE (Draw - Ellipse ... ) omogucuje crtanje elipse i elipti¢nog luka.

Crtanje elipse omoguceno je na dva nacina (slika 2.4):

o zadavanjem sredista elipse i krajnjih totaka osi & Center

Prvi je korak definiranje srediSta (tocka 1 — slika 2.4.a) elipse (Specify center of ellipse):

ELLIPSE Specify center of ellipse:

Sljedeci je korak definiranje krajnje tocke (2) osi (Specify endpoint of axis):

ELLIPSE Specify endpoint of axis:

te udaljenosti do druge osi (Specify distance to other axis or [Rotation]), to¢ka 3 — slika
2.4.a):

ELLIPSE Specify distance to other axis or [Rotation]:

e zadavanjem krajnjih totaka osi <> Auis, End

Prvi je korak definiranje krajnje toc¢ke (tocka 1 — slika 2.4.b) elipse (Specify axix endpoint of
ellipse or [Arc Center]):

ELLIPSE Specify axis endpoint of ellipse or [Arc Center]:

Sljedeci je korak definiranje druge krajnje tocke (tocka 2 — slika 2.4.b) osi (Specify other
endpoint of axis):

ELLIPSE Specify other endpoint of axis:

te udaljenosti do druge osi (Specify distance to other axis or [Rotation]), to¢ka 3 — slika
2.4.b):
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ELLIPSE Specify distance to other axis or [Rotation]:

a) zadavanje sredista b) zadavanje krajnjih to¢aka

Slika 2.4. Nacini crtanja elipse

Elipti¢ni luk (Draw = Ellipse & Arc =)

e zadati elipsu (smjer zadavanja dulje osi elipse zdesna nalijevo — zbog mjerenja kuta)

e zadati pocCetni kut luka (Start engle)

e zadati zavr$ni kut luka (End angle) ili ukljuéeni kut luka (Included angle). Prema slici
2.5 zavr$ni kut luka iznosi 150°, dok ukljuceni kut luka iznosi 105°.

3
15p. ~

Slika 2.5. Definiranje to¢aka elipti¢nog luka

Definiranje osi elipse (to¢ka 1 — slika 2.5) ili elipti¢nog luka:

ELLIPSE Specify axis endpoint of elliptical arc or [Center]:

Definiranje druge osi elipse (tocka 2 — slika 2.5):

ELLIPSE Specify other endpoint of axis:

Definiranje udaljenosti do druge osi (tocka 3 — slika 2.5):

ELLIPSE Specify distance to other axis or [Rotation]:
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Zadavanje pocetnog kuta luka:

ELLIPSE Specify start angle or [Parameter]:

Zadavanje zavr$nog (end) ili uklju¢enog (Included) kuta luka:

ELLIPSE Specify end angle or [Parameter Included angle]:

2.9. SPLINE KRIVULJA

Naredba SPLINE (Draw =» Spline ... £ ) omogucuje crtanje kvadratne ili kubne spline
krivulje (slika 2.6).

Spline krivulja je glatka krivulja koja prolazi kroz niz zadanih toCaka sa zadanom
tolerancijom.

Prilikom crtanja spline krivulje potrebno je:
e zadati niz tocaka kroz koje krivulja prolazi
e zadati nagib tangente u pocetnoj toc¢ki (start Tangency)
e zadati nagib tangente u krajnjoj tocki (end Tangency).

Mogucée je naknadno promijeniti nagib tangente u svakoj definiranoj tocki.

Prilikom crtanja spline krivulje potrebno je ISKLJUCITI opciju pravokutnog crtanja
(ORTHO mode)!!!

Definiranje prve toc¢ke spline krivulje:

SPLINE Specify first point or [Viethod Knots Object]:

Definiranje druge tocke spline krivulje (ili nagib tangente u pocetnoj tocki):

SPLINE Enter next point or [ start Tangency tol_erance]:

Definiranje tre¢e tocke spline krivulje (ili nagib tangente u krajnjoj tocki):

SPLINE Enter next point or [ end Tangency tol erance Undo]:

Definiranje ¢etvrte tocke spline krivulje (ili nagib tangente u krajnjoj tocki):

SPLINE Enter next point or [ end Tangency tol erance Undo Close]: ENTER

Danijela Pezer, pred.



RACUNALOM PODRZANO OBLIKOVANJE

Naredbu nastavljamo i ponavljamo prethodne korake sve dok ne iscrtamo zeljenu spline
krivulju.

Opcija Method kontrolira je li spline krivulja izradena odredenim to¢kama (fit points) ili
kontrolnim vrhovima (Control Vertices — CV) — sustavna varijabla SPLMETHOD.

Metoda izrade spline krivulje kontrolnim vrhovima Kkoristi se za stupnjevanje krivulja u
rasponu od 1 do 10 ( stupanj 1 — linearna, stupanj 2 — kvadratna, stupanj 3 — kubna ...).

Namjestanje oblika krivulje pomicanjem vrsnih tocaka ¢esto daje bolje rezultate od pomicanja
namjeStenih tocaka.

Opcija Knots odreduje parametre ¢vorova (sustavna varijabla SPLKNOTS).
Opcija Object pretvara prethodno priredenu poliliniju u spline krivulju.
Opcija Close spaja pocetak i kraj krivulje.

Naredba zavrsava tipkom ENTER.

Slika 2.6. Spline krivulja

Ako odaberemo opciju tolerance, sljede¢i je korak definiranje vrijednosti fit tolerance:

SPLINE Enter next point or [ start Tangency tol erance]:

SPLINE Specify fit tolerance <0.0000>:

Opcijom fit tolerance mijenja se vrijednost tolerancije koju mora zadovoljiti krivulja prilikom
prolaska kroz toc¢ke. Vrijednost tolerancije 0 zahtijeva da krivulja prolazi to¢no kroz tocke.

U strojarstvu spline krivulja pronalazi primjenu prilikom crtanja djelomi¢nih presjeka (slika
2.7).
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spline
krivulja

=

<

Slika 2.7. Primjena spline krivulje kod djelomi¢nog presjeka prikaza sredi$njeg gnijezda

2.10. OBLIKOVANI TEKST

Naredba STYLE (Draw - Text Style A ) omogucuje izbor [ s -
stila teksta (neposredno prije unosa teksta). | e
/~ Ray
Naredba MTEXT (Draw = Text = Multiline Text) |7 cmrertr
omogucuje unos teksta unutar definiranih granica. > Polyline
%1 3D Polyline
Prvi je korak definiranje prvog ugla granice ispisa teksta: =
2 Helix
MTEXT Specify first corner: e :
@ onut
Zpline 3
Sljedeci je korak definiranje drugog, odnosno suprotnog ugla — .
granice ispisa teksta: R Tabe..
. ’
MTEXT Specify opposite corner or [Height Justify 5 Gradiert..
Line spacing Rotation Style \Width Columns]: B s
egion
[5 Wipeout
[3 Revision Cloud
Posljednji korak ¢ini unos teksta i njegovo oblikovanje u Tet | A Mutiine Te..
tekstnom editoru (Text Editor). Al Single Line Text

Alatna traka za oblikovanje teksta Text Editor (slika 2.8) sadrzi sljedece:

padajuci popis dostupnih stilova

padajuci popis dostupnih oblika slova (Font)

padajuci popis veliCine slova

gumb za poravnanje (Justification) — omoguéuje centriranje teksta unutar zadanih
granica (npr. centriranje teksta u zaglavlju/sastavnici)

e gumb za podebljavanje teksta (Bold)
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e gumb za skosenje teksta (Italic)

e gumb za podcrtavanje teksta (Underline)

e gumb za ponistavanje (Undo) i vracanje poniStene radnje (Redo)

e gumb za ispis simbola (@ Symbol) — npr. simbol promjera fi (%%C), simbol stupnja °
(%%d) itd.

ns  Symbol Field | Spell
- Check

|=1ToplI2D Wireframe]

Slika 2.8. Oblikovanje teksta

Naredba DTEXT (Draw = Text = Single Line Text Al) omogucuje unos redaka teksta.

Prvi je korak definiranje polazne tocke teksta:

DTEXT Specify start point of text or [Justify Style]:

Sljedeci je korak definiranje visine teksta:

DTEXT Specify height <2.5000>:

Zatim slijedi definiranje kuta zakreta teksta:

DTEXT Specify rotation angle of text <0>:

Posljedn;ji korak ¢ini unos teksta. Tekst je moguce unositi visestruko, bez ponovnog pozivanja
naredbe. Tipkom ESC zavr$savamo naredbu.
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3. ALATI ZA PRECIZNO CRTANJE

Alati, odnosno pomagala za precizno crtanje jesu sljedeci:
e Kkorak (Snap)
e mreza (Grid)
e nisani (Object Snap)
e odmak od referentne toc¢ke (Point Offset from a Reference Point)
e automatsko prac¢enje (AutoTrack)
e koordinatni filtri (Coordinate Filters).

3.1. KORAK

Korak (Snap) — predstavlja nevidljivu mrezu tockica po kojima se kre¢e pokaziva¢ misa,
pomak koji prilagodujemo postavljenoj mrezi.
Snap je moguce ukljuciti i funkcijskom tipkom FO9.

3.2. MREZA

MreZa (Grid) — pomoéna mreza to¢kica u prozoru crteza (ne iscrtava se na papiru!)

AKO je mreza pregusta, potrebno je povecati razmak izmedu tockica (dijaloski okvir Drafting
Settings).

Grid je moguée ukljuciti i funkcijskom tipkom F7.

3.3. ORTOGONALNO CRTANJE

Uz pomocéne funkcije Snap i Grid na statusnoj traci mozemo pronaci i pomo¢nu funkciju
Ortho koja omogucuje horizontalno i vertikalno crtanje, pri ¢emu je mi$ potrebno usmjeriti u
zeljenom smjeru crtanja linije.

Ortho je moguce ukljuciti i funkcijskom tipkom F8.

3.4. PRACENJE

Ugradene rutine prac¢enja (Tracking) olaksavaju postavljanje novog objekta u odnosu na drugi
objekt. Praéenjem se mozemo koristiti umjesto promjenom referentne toc¢ke (FROm), koja se
upotrebljava zajedno s niSanima, te umjesto koordinatnim filtrima koji izlu¢uju odabranu
koordinatnu vrijednost zadane tocke (poravnavanje tocaka po osi X ili Y).

e Pracenje duz specifi¢nih to¢aka objekata (Object snap tracking — OTRACK)

Pracenje duz specificnih tocaka objekata koristi se zajedno s aktivnim niSanima. Aktivacija
rutine pracenja na statusnoj liniji ikonom OTRACK. Kako bi se izvrsilo pracenje, potrebno je
zadrzati mi$ nad Zeljenom tockom (uz aktivan odgovarajuci niSan) te pomicanjem misa duz
zeljene putanje (u ravnini s odabranim to¢kama) zadati tocku.

Pracenje se odvija duz pravokutnih linija, a zelimo li realizirati pracenje pod nekim kutom, to
je moguce definirati u postavkama.

e Polarno pracenje (Polar Tracking)
Polarno pracenje aktivira se na stausnoj liniji ikonom Polar.
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3.5. NISANI

Nisani (Object Snap — OSNAP) omogucuju precizno crtanje pogadanjem specifi¢nih to¢aka

ve¢ nacrtanih objekata.

AutoCAD

Moguce ih je pozvati s alatne trake Object snap ili plutajuéeg izbornika nisana (tipka Shift +

desni klik misa) ili pozivanjem u naredbenom retku.

Desnim klikom misa na gumb OSNAP na statusnoj alatnoj traci prikazuje nam se popis
ni$ana, a uz one aktivne stoji znak kvacice v.

Temporary track point -
FROm HE — promjena referentne tocke

Mid between 2 Points — pronalazi poloviste izmedu dviju tocaka
ENDpoint B8, [0 - pogada najblizu krajnju tocku objekta

MIDpoint B, A — pogada poloviite objekta

INTersection B , X —pogada sjeciste objekata, i u produzetku objekata

APParent intersection B ) — pogada prividno sjeciste objekata koji se
ne sijeku u prostoru, i u produzetku objekata

EXTension B8, X — pogada to¢ku u nastavku objekta
CENter &1, O — pogada srediste (kruznice, luka, elipse)

QUAdrant B <- pogada najblizu kvadrantnu tocku (kruznice, luka,
elipse) odnosno mjesto gdje osi koordinatnog sustava sijeku objekt

TANgent 1 O - pogada tangentno na kruznicu ili luk

PERpendicular EH, |:|_ — pogada okomito na zadani objekt, i u
produzetku

PARallel B4, # — pogada paralelno na zadanu liniju

INSertion E, 0, — bazna tocka umetanja bloka, teksta i sl.
NODe B ® - pogada tocku objekta

NEArest B, X — pogada najblizu to¢ku na objektu
NONe [ - iskljuduje aktivni nigan
— postavke niSana

Tipka TAB izmjenjuje moguce tocke nisana!

Naredba OPTIONS (Tools = Options...), kartica Draftings, okviri AutoSnap Settings —
omogucuje prilagodavanje veli¢ine markera (AutoSnap Marker Size), veli¢ine otvora

(Aperture Size)...
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4. RAZINE (LAYER)
Razina ili sloj (Layer) omoguéuje grupiranje objekata prema zajedni¢kim svojstvima.

Zajednicka svojstva objekta:
e Dboja (Color)
e vrsta linije (Linetype)
e debljina linije (Lineweight).

Grupiranje objekata prema zajedni¢kim svojstvima znacajno pridonosi preglednosti crteza |
olakSava baratanje objektima na crtezu.

Svaka novootvorena datoteka ima zadanu (defaultnu) razinu, odnosno razinu 0.

Naredba LAYER (Format -> Layer) — poziva dijalog za baratanje razinama Layer
Properties (slika 4.1) u kojem kreiramo slojeve i pridruzujemo im karakteristike (boja, vrsta
linije, debljina linije).

Current layer: Puna

_—

= W | 55

Filters “ 5. Mame
== M Tanka

@ All Used Layers Defpo
Simetrala

Color  Linetype  Lineweig..
W 52 Continu..
. w h
ma... AG
[ ]
72
red
W4l
. w hn. -:_ L

cints

Presjek

ko
Isprekidana
]

= - -8 -8 -8 -8 -9 -8

[
B B, 8 8 [ENa E m
.';‘l .'il .';‘l .’il .';‘I .';‘l .';‘I .';‘l :2

W Invert filter &«

.~ All: 8 layers displayed of 8 total layers

Slika 4.1. Dijalog za kreiranje razina

Najcesce koristeni slojevi (u strojarstvu) jesu oni za definiranje pune debele linije i tankih
linija (kote, isprekidane linije, simetrale).

Svakoj od ovih linija pridruzuje se razlicita boja.

Debljinu linije moZemo definirati na nacin da su sve tanke (kota, isprekidana, simetrala) linije
za polovinu tanje od definirane pune debele linije.

Ako prilikom crtanja zelimo imati prikaz debljina linija, mozemo ga aktivirati U postavkama
(Format = Lineweight... = Lineweight Settings) tako $to oznac¢imo (kvacica) opciju

Display Lineweight (prikazano na slici 4.2) ili klikom na gumb E na statusnoj traci. Ako
gumb nije vidljiv na statusnoj traci, oznac¢imo naredbu u opciji Customization koja se nalazi u

donjem desnom uglu ekrana — gumb E :
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Layer...

% Layer States Manager...

Layer tools

G Color...

Linetype...
Lineweight...

Transparency
Scale List...

Text Style...
Dimension Style...
Table Style...
Multileader Style
Plot Style...

Point Style...
Multiline Style...

LA NE LR N i

Units...
Thickness

Drawing Limits

H HOB

Rename...

AutoCAD

Lnits for Listing
(@ Milimeters {mm)

E Display Lineweight

() Inches {in)

Defautt

[ — 025mm -

Adjust Display Scale

Min - B

E Current Lineweight: Bylayer

[ ok

| | Cancel | | Hep

]

Mlanc

Slika 4.2. Prikaz debljina linija u radnom prostoru AutoCAD-a

Vrsta linije (npr.):

Stvaranje nove razine

Pozivanjem naredbe LAYER
Odabrati New Layer (Alt+N) E&
Unos imena nove razine u stupcu Name
Odabir boje u stupcu Color

Odabir vrste linije u stupcu Linetype (odabirom Load po potrebi ucitavamo dodatne
vrste linija (slika 4.3)

puna debela linija (puna) — Continuos
kota — Continuos

simetrala — ACAD_1SO04W100 (ISO long-dash dot)
isprekidana — ACAD_ISO02W100 (1SO dash).

e Odabir debljine linije u stupcu Lineweight
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Fle... frcadiso.in}

Available Linetypes
Loaded linetypes
Linetype Descrption i
Linetype Appearance Description D
ACAD_ISO02W100 I50dash _ _ _
ACAD_ISO02W100 — — ——180dssh _ __ _ ACAD, ISO03W100 SO dash
ACAD_ISOD3W100 . __I50dsshspace _ __ __ - asnspEce — — — — — —
e I ACAD_ISO04W100 150 long dash dot R
N N ACAD_ISO05W100 150 long-dash double-dot
Cortinuous Sold line
ACAD_ISO06W100 150 long-dash triple-dot .
ACAD_ISOO7WI00 150dot ...
ACAD_ISO08W100 150 long-dash short-dash _ _ -
o« 0 | b < | 1 ] b
[ ok | [ cameed | [ load. | [ Hep | [ok | [ cacel | [ Heb |

Slika 4.3. U¢itavanje dodatnih vrsta linija
Odabir radne razine
Radnu razinu (Current Layer) moguce je odabrati na vise nacina.

e Najjednostavniji nacin odabira radne razine jest preko padajuceg popisa razina Layer
Control na traci s alatima Layers gdje zeljenu razinu oznacimo (Slika 4.4).

kota
o HO
o I Defpoints
o W Isprekidana

fpu
g - (1] kota
—J0) Presiek
= Make Current = —
= ¥ L o
La'-,-'er o W Puna
F'ru:upr—_-rties. g-.: Match LE}"EI' o Simetrala

® % o M Tanka

.. v . . . i . y c oy g
e Drugi je nacin odabirom ikone Layer Properties @&Eisl zatim oznacavanje Zeljene

razine i odabir na gumb E8 Set Current (Alt+C), ili dvoklikom na Zeljenu razinu.

e Treci je nadin pozivanje naredbe LAYER, zatim oznacavanje Zeljene razine i odabir
na gumb E=8 Set Current (Alt+C), ili dvoklikom na Zeljenu razinu.

Promjena imena razine

Promjena imena razine moguca je dvoklikom na Zeljenu razinu i unosom novog imena u
stupcu Name.

Brisanje razine

AKo umetnemo crtez iz druge datoteke, taj crtez automatski preuzima svojstva razina
definirana tom datotekom. Ako se te razine ne podudaraju s razinama aktivne datoteke,
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mozemo ih obrisati pomocu Delete (Alt+D) u dijalogu za baratanje razinama (Layer
Properties) ikonom E=

Promjena razine objekta

Promjena razine objekta moguca je odabirom Zeljenog objekta, a na padaju¢em popisu razina
odabiremo novu zeljenu razinu.

Stanja razine

Ukljuéena ili isklju¢ena (On/Off) %/ ¥

e ako je razina ukljucena, objekti su te razine vidljivi i ispisuju se

Zamrznuta ili odmrznuta (Freeze/Thaw in All Viewports) 4%/ E2
e ako je razina zamrznuta, objekti su te razine nevidljivi, ne preraCunavaju se i ne
ispisuju se
e zamrzavanje nepotrebnih objekata ubrzava rad s datotekama
Zakljuéana ili otkljuéana (Lock/Unlock) & / of
e objekti zakljuCanih razina nisu dostupni za odabir ili promjenu, ali su vidljivi i moguce
ih je pogoditi niSanima
Stil ispisa (Plot Style)
e promjena stila ispisivanja razine (ako se radi sa stilovima ispisa ovisnim o bojama,
nije moguca promjena stila)
Ispisivati ili ne ispisivati (Plot/Don't Plot) =/ S

e ovom opcijemo odredujemo hoce li se objekt u odabranoj razini ispisivati ili ne
(pogodno za konstrukcijske linije).
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5. UPRAVLJANJE OBJEKTIMA

Naredbe za upravljanje objektima nalaze se u padaju¢em izborniku Modify ili istoimenoj
alatnoj traci.

8 = mE : p | ¥
ey N ol S L Rl KRR ctna traka Modify
5.1. KOPIRANJE OBJEKATA ::i?;;emes
Change to BylLayer
Objekte u AutoCAD-u mogucée je umnoZzavati, odnosno kopirati na S::Ct :
Vlée naélna' Annotative Object Scale 4
. ) . i ; : A . : _/_ Erase
Prilikom kopiranja objekta nastaje novi objekt jednak izvornomu, [oz cop
medutim sa zadanim pomakom u odnosu na izvorni objekt. i e
AL Offset
Arra 3
Najcesce koriSten pristup jest pozivanje naredbe COPY (moguce joS i | 4 Dele)t‘reDupIicateObjects
kopiranje pomocu hvataljki, kopiranje povladenjem i spuStanjem — | wove
Drag and Drop, kopiranje pomoc¢u kombinacija tipki Ctrl+C i Ctrl+V  |O Retate
itd). B ore
H/'" Lengthen
o == Trim
Naredba COPY (Modify = Copy ©) omoguéuje Kopiranje _’_f_, me,
objekata. £ Break
+ loin
Varijabla COPYMODE odreduje broj moguceg kopiranja odabranog g ;::tmfer

objekta pozivom naredbe COPY.

Blend Curves

3D Operations

»

Unosom COPYMODE u naredbeni redak mozemo definirati zelimo li Solid Eciting '
. . . . T VERT Surface Editing 3

da nam odabrani objekt bude kopiran samo jednom ili Zelimo Mesh Ediing ,
omoguc’iti viSestruko kopiranje. Point Cloud Editing v

P2 Change Space
Unosom broja 1 omoguceno je kopiranje samo jednog objekata, dok |G Eelode

se unosom 0 omogucuje visestruko kopiranje. Padajuéi(jizfl;/omik
Modi

Zadana (defaultna) vrijednost je 0.

COPYMODE Enter new value for COPYMODE <0>:

Prvi je korak prilikom pozivanja naredbe COPY odabir (lijevim klikom odabir, zatim potvrda
desnim klikom) objekata koje zelimo kopirati:

COPY Select objects:

Sljedeci je korak odabir hvatista:
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COPY Specify base point or [Displacement mOde] <Displacement>:

Sljedeci je korak zadavanje pomaka kopije:

COPY Specify second point or [Array] <use first point as displacement>: 37.5

Prema primjeru (slika 5.1) svaki sljede¢i pomak racuna se od osnovne tocke (base point) ili
hvatista.

Naredba zavrsava tipkom ENTER ili ESC.

Ako odaberemo opciju Array unutar naredbe copy, radi se o visestrukom kopiranju, pri
kojemu je potrebno unijeti broj kopija (Enter number of items to array) i drugu to¢ku (Specify
second point or [Fit]), Sto zapravo predstavlja udaljenost medu njima (ako nam je hvatiste u
sredistu kruznice, dovoljno je jednom unijeti zeljeni razmak — 37,5 prema slici 5.1, te ¢e se
izvrsiti kopiranje za zadani broj kopija).

79 |
12,5

Slika 5.1. Visestruko kopiranje

5.2. PARALELNO KOPIRANJE

Naredba OFFSET (Modify > Offset € ) omoguéuje kopiranje postojeéeg objekta na
zadanoj udaljenosti.

Prvi korak prilikom pozivanja naredbe OFFSET jest definiranje zadane udaljenosti na kojoj
¢emo kopirati Zeljeni objekt:

OFFSET Specify offset distance or [ Throgh Erase | ayer] <1.0000>: 10

Sljedeci je korak odabir strane (vanjska ili unutarnja) s koje zelimo kopirati objekt/objekte:

OFFSET Specify point or side to offset or [Exit Multiple Undo] <Exit>:
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Nakon odabrane strane objekt se kopira na zeljenoj udaljenosti, a za ponavljanje ove radnje
potrebno je ponovno naznaciti objekt kako bi se kopirao na istoj udaljenosti (s tim da je
moguce promijeniti stranu bez ponovnog pozivanja naredbe).

OFFSET Select object to offset or [Exit Undo] <Exit>:

Ako zelimo visestruko kopiranje za zadanu udaljenost, nakon definiranja udaljenosti i odabira
izvornog objekta potrebno je odabrati opciju Multiple te kliknuti (lijevim klikom) onoliko
puta koliko zelimo kopiranih objekata.

Prema slici (5.2) izvrSeno je kopiranje pravokutnika pocetnih dimenzija 120 x 70 mm, na
zadanoj udaljenosti 10 mm (odabrana je unutarnja strana pravokutnika za kopiranje). 1z slike
je vidljivo da takav nacin kopiranja objekata umanjuje (odnosno uveéava) dimenzije
odabranog objekta za zadanu udaljenost (s obje strane).

10

10

10

70

120

Slika 5.2. Paralelno kopiranje (offset)
Kad bi se radilo o kakvoj liniji, njezina bi dimenzija ostala nepromijenjena, te bi se izvrSilo

kopiranje na zadanoj udaljenosti.

5.3. ZRCALJENJE

Naredba MIRROR (Modify = Mirror 4t) omoguéuje zrcaljenje odabranih objekata oko
linije zrcaljenja.

Prvi korak prilikom pozivanja naredbe MIRROR jest odabir objekata koje zelimo zrcaliti:

MIRROR Select objects:

Sljedeci je korak odabir prve tocke zrcalne linije:

MIRROR Specify first point of mirror line:

Nakon toga potrebno je odabrati drugu tocku zrcalne linije:
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MIRROR Specify second point of mirror line:

Zatim odabiremo Zelimo 1i zadrZati originalni objekt ili ga Zelimo izbrisati (u ovom primjeru
zadrZan je original, $to je i potvrdeno tipkom ENTER.

MIRROR Erase source objects? [Yes No] <No>: ENTER

Na slici 5.3.a) prikazan je trokut koji je zrcaljen oko svog vrha. Slika 5.3.b) prikazuje
zrcaljenje objekta bez zrcaljenja teksta, dok slika 5.3.c) prikazuje zrcaljenje objekta sa
zrcaljenjem teksta.

Varijabla MIRRTEXT odreduje zrcaljenje teksta.

Unosom MIRRTEXT u naredbeni redak mozemo definirati Zelimo 1i zrcaljenje teksta ili ne.
Unosom broja 1 tekst se zrcali, dok se unosom 0 tekst ne zrcali.

Zadana (defaultna) vrijednost je 0.

MIRRTEXT Enter a new value for MIRRTEXT <0>:

a) b) c)

Slika 5.3. Zrcaljenje objekata

5.4. RASPOREDIVANIJE U POLJU

Naredba ARRAY (Modify = Array E) omogucuje visestruke kopije objekata rasporedene
u pravokutnom ili polarnom polju.

5.4.1. Pravokutno rasporedivanje (Rectangular Array 88)

Prilikom pravokutnog rasporedivanja (slika 5.4) prvi je korak odabir objekata koje Zelimo
visestruko pravokutno kopirati:

ARRAYRECT Select objects:

U sljede¢em koraku odabiremo retke (Rows) ili stupce (COLumns) pri ¢emu redoslijed nije
bitan. U navedenom primjeru prvo su odabrani stupci:
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ARRAYRECT Select grip to edit array or [ASsociative Base point COUnt Spacing
COLumns Rows Levels eXit ] <eXit>: COLumns

Nakon odabira stupaca unosimo broj Zeljenih stupaca (npr. 4):

ARRAYRECT Enter the number of columnss or [Expression] <3>: 4

Nakon odabira stupaca potrebno je definirati udaljenost izmedu njih (npr. 150):

ARRAYRECT Specify the distance between columns or [Total Expression] <129.9038>:
150

Sljedeci je korak odabir redaka:

ARRAYRECT Select grip to edit array or [ASsociative Base point COUnt Spacing
COLumns Rows Levels exit ] <eXit>: Rows

Nakon odabira redaka unosimo broj zeljenih redaka (npr. 3):

ARRAYRECT Enter the number of rows or [Expression] <3>: ENTER

Zatim definiramo razmak izmedu redaka (npr. 150):

ARRAYRECT Specify the distance between rows or [ Total Expression] <112.5>: 150

Tipkom ESC zavrSsavamo s naredbom.

loleXexe
OO0
OO0

150

150

Slika 5.4. Pravokutno rasporedivanje
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Visestruko pravokutno rasporedivanje mozemo izvrsiti i naredbom ARRAYCLASSIC pri

¢emu nam se otvara dijalog Array.

e U dijalogu Array odabrati opciju pravokutnog rasporedivanja (Rectangular Array)

(slika 5.5).

e Klikom na ,,odabir objekata“ (Select objects) u radnom prostoru odabiremo Zeljene

objekte koje ¢emo visestruko rasporedivati.

e Unijeti broj redaka (Rows) i broj stupaca (Columns).

e Unijeti razmak izmedu redaka (Row offset) i stupaca (Column offset) te nagib (Angle
of array) pod kojim Zelimo da nam objekti budu rasporedeni (prema slici nije

definiran nagib, te je vrijednost 0).

e Opcijom Preview pregledavamo zadane postavke (tipkom ESC vra¢amo se na dijalog
Array ako zelimo neSto izmijeniti, u suprotnom tipkom ENTER potvrdujemo

rasporedivanje).

i@ Rectangular Amay () Polar Amay

Rows: 3 [[]] Columns: 4

Offset distance and direction

Row offset: 150
Column offset: 150
Angle of amay: 0

(1) By default, if the row offset is negative,
S rows are added downward. K the

column offset is negative, columns are
TP added to the left.

Select objects

1 objects selected

e e s o
s I e
e B e e o

Slika 5.5. Pravokutno rasporedivanje pomo¢u ARRAY CLASSIC

5.4.2. Kruzno rasporedivanje (Polar Array =)

Prilikom kruznog rasporedivanja (slika 5.6) prvi je korak odabir objekata koje zelimo

visestruko kruzno kopirati:
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ARRAYPOLAR Select objects:

U sljede¢em koraku odabiremo osnovnu tocku ili hvatiste (base point) koja zapravo
predstavlja polozaj srediSnje toCke zamiSljene kruznice po kojoj ¢e objekti biti kruzno
rasporedeni:

ARRAYPOLAR Specify base point of array or [Base point Axis of rotation] :

Sljedeci je korak odabir stavki, odnosno kopija objekata (Items):

ARRAYPOLAR Select grip to edit array or [ASsociative Base point Items Angle
between Fill angle ROWs Levels ROTate items eXit ] <eXit>: Items

Nakon odabira stavki (kopija objekata) unosimo broj Zeljenih objekata (npr. 8):

ARRAYPOLAR Enter number of items or [Expression] <6>: 8

Tipkom ESC zavrSavamo s naredbom.

.

@ -
- ~
- ~
¢
’
/
s

Slika 5.6. Kruzno rasporedivanje

Visestruko kruzno rasporedivanje mozemo izvrsiti i naredbom ARRAYCLASSIC pri ¢emu
nam se otvara dijalog Array.

e U dijalogu Array odabrati opciju kruznog rasporedivanja (Polar Array) (slika 5.7).

e Klikom na ,,odabir objekata* (Select objects) u radnom prostoru odabiremo Zeljene
objekte koje ¢emo visestruko rasporedivati.

e Klikom na sredi$nju to¢ku (Center point) u radnom prostoru odabiremo polozaj
srediS$nje tocke zamisljene kruznice po kojoj ¢e objekti biti kruzno rasporedeni.

e (Odabiremo nacin kruznog rasporedivanja zadavanjem:
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o ukupnog broja stavki (kopija objekata) i kuta ispunjenja (Total number of items
& Angle to fill)

o Uukupnog broja stavki (kopija objekata) i kuta izmedu njih (Total number of
items & Angle between items)

o kuta ispunjenja i kuta izmedu stavki (kopija objekata) (Angle to fill& Angle
between items).

e Odrediti opciju rotiranja kopija
e Opcijom Preview pregledavamo zadane postavke (tipkom ESC vra¢amo se na dijalog

Array ako zelimo neSto izmijeniti, u suprotnom tipkom ENTER potvrdujemo
rasporedivanje).

e S

1 Rectangular Amay @ Polar Amay Select objects

Center point: W 277 Y. 1363

0 objects selected

Method and values
Method: |:| &

Total number of tems & Anagle to fill v] % —
Total number of tems: ) ¥ %
Angle to fill 260 = & |:|
Angle between tems: 45 m

| 'ij| For angle ta fill, a postive value specifies
5 counterclockwise rotation. A negative value
gpecifies clockwise rotation.

[] Rlotate items as copied More ¥
Help
Slika 5.7. Kruzno rasporedivanje pomo¢u ARRAY CLASSIC
Razlika izmedu naredbe ARRAY u novijim verzijama AutoCAD-a i naredbe

ARRAYCLASSIC (ARRAY u starijim verzijama) u tome je sto kod naredbe ARRAY objekti
viSestrukog kopiranja predstavljaju jedan objekt, dok su objekti dobiveni viSestrukim
kopiranjem pomocu naredbe ARRAYCLASSIC zapravo zasebni objekti (to je bitno prilikom
koristenja odredenih drugih naredaba, npr. TRIM).

5.5. POMICANJE OBJEKATA

Naredba MOVE (Modify > Move %) omogucuje pomicanje objekata (slika 5.8) za zadani
pomak.

Prvi korak prilikom pomicanja objekata jest odabir objekata koje zZelimo pomaknuti:
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MOVE Select objects:

Odabir potvrdujemo tipkom ENTER.

Odabir tocke hvatista pomocu koje ¢emo objekt pomaknuti za zadani pomak:

MOVE Specify base point or [Displacement] <Displacement>:

Definiranje udaljenosti za koju Zelimo izvrS$iti pomicanje objekata:

MOVE Specify second point or < use first point of displacement>:

Slika 5.8. Pomicanje objekata

5.6. ROTACIJA OBJEKATA

Naredba ROTATE (Modify > Rotate © ) omoguéuje zakretanje objekata (slika 5.9) oko
hvatista 2.

Slika 5.9. Zakretanje (rotacija) objekata
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Prvi je korak odabir objekta (lijevi, zatim desni klik misa) koji Zelimo rotirati:

ROTATE Select objects:

Sljedeci je korak odabir hvatista oko kojeg ¢e se izvrsiti zakret (rotacija):

ROTATE Specify base point:

Potrebno je definirati Zeljeni kut zakreta (npr. 75 prema slici 5.9):

ROTATE Specify rotation angle or [Copy Reference] <90>: 75

Ako prilikom rotacije zelimo zadrZati izvorni objekt, potrebno je najprije odabrati opciju
Copy, zatim definirati zeljeni kut zakreta.

5.7. ISTEZANJE OBJEKATA

Naredba STRETCH (Modify = Stretch [ ) omogucuje istezanje objekata oko hvatista.

Potrebno je odabrati dio objekta koji zelimo izduziti (slika 5.10).
Naredba se izvrSava ispravno samo ako selektiramo objekt zdesna nalijevo (selektiranje
slijeva nadesno prekida naredbu!!!).

STRETCH Select objects:

Slika 5.10. Odabir objekata izduzivanja

Nakon odabira objekta objekt potvrdujemo desnim klikom misa (ENTER).

Sljedeci je korak odabir hvatista (trokuti¢ na slici 5.11) oko kojeg je izvrSeno izduzenje:

STRETCH Specify base point or [Displacement] <Displacement>:
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Slika 5.11. Odabir hvatista (,,trokuti¢*)

Sljedeci je korak odabir druge toc¢ke (udaljenost za koju ¢e se izvrsiti izduzenje (slika 5.12) —
npr. 100 mm:

STRETCH Specify second point or <use first point as displacement>: 100

Slika 5.12. Odabir tocke istezanja

Konacan izgled objekta prikazan je naslici 5.13.

Slika 5.13. Konacan izgled objekta nakon istezanja

5.8. PROMJENA NA MJERU

Naredba SCALE (Modify = Scale ©l) omogucuje smanjenje ili uvecanje objekata za
zadanu mjeru (slika 5.14).

Prvi je korak odabir objekata (lijevi, zatim desni klik misa) ¢iju mjeru zelimo promijeniti:

SCALE Select scale objects:

Sljede¢i je korak odabir hvatista u odnosu na koje ¢e se izvrSiti promjena uvecéanja ili
smanjenja:
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SCALE Specify base point:

Potrebno je definirati faktor promjene na mjeru (npr. 0,5 $to znaci da ¢emo objekt umanjiti —
slika 5.14.a)):

SCALE Specify scale factor or [Copy Reference]: 0.5

- - - - - = |
| |
| |
| |
| |
| |
| | o o
| N — — — 1 1 o
| \
| |
(e ‘ o
0 | D
\
|
|
|
E —
35 39
70 70
a) b)

Slika 5.14. Promjena veli¢ine objekta — smanjenje a); uvecanje b)

5.9. IZDUZIVANIJE

Naredba EXTEND (Modify > Extend ) omogucuje izduZivanje objekta do drugog
objekta.

EXTEND Select objects or <select all>: ENTER

Ako nakon pozivanja naredbe EXTEND odaberemo opciju ,,0znaci sve (select all),
omoguceno nam je jednostavno izduzivanje na zeljenom objektu priblizavanjem pokazivaca
misa na objekte koje zelimo izduziti u odnosu na druge objekte.

Odabir potvrdujemo lijevim klikom misa.
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5.10. ODSIJECANJE

Naredba TRIM (Modify & Trim *°) omoguéuje odsijecanje objekta od ruba rezanja
zadanoga drugim objektima (slika 5.15).

A2 s A
A /ﬁ/ ‘
S g 2 ||
eyt e | =
25 30 25 30;% © 30
a) b) c)

Slika 5.15. Odsijecanje objekata

TRIM Select objects or <select all>: ENTER

Ako nakon pozivanja naredbe TRIM odaberemo opciju ,,0znaci sve* (select all), omoguceno
nam je jednostavno odsijecanje na zeljenom objektu priblizavanjem pokaziva¢a miSa na
objekte koje zelimo isje¢i (objekti koji ¢e biti isjeceni postaju svjetliji), te klikom na te
objekte.

TRIM [Fence Crossing Project Edge eRase Undo]:

Opcija Edge odreduje hoce li se objekt odsijecati od produzetka grani¢nog ruba:

TRIM Enter an implied edge extension mode [Extend No extend]: <Extend>

5.11. IZVODENIJE SKOSENJA

Naredba CHAMFER (Modify = Chamfer ﬂ) omogucuje skoSenja na uglove objekata
(slika 5.16).

DI _ DI

v '

i
I )

!

D2

Slika 5.16. Skosenje objekata
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CHAMFER Select first line or [Undo Polyline Distance Angle Trim mEthod Multiple]:

Nakon pozivanja naredbe CHAMFER mozemo odabrati izmedu dva nacina izvodenja
skoSenja odabirom opcije Distance ili Angle.

Distance — zadavanje dviju udaljenosti (D1 i D2)
Angle — zadavanje udaljenosti D1 i kuta skoSenja

Odabiremo opciju ovisno o zadanim kotama. Ako je definirano skoSenje pod kutom od 45°,
vrijednosti D1 i D2 moraju biti jednake.

Polyline — skoSavanje polilinije
Trim — odreduje zadrzavaju li se uglovi nakon skoSavanja
Multiple — visestruko skosavanje

Method — kontrolira na koji se nacin linija skoSenja izracunava iz to¢ke sjeciSta odabranih
objekata ili segmenata linija (preko udaljenosti Distance ili kuta Angle):

CHAMFER Enter trim method [Distance Angle]: <Distance>

Sustavna varijabla EDGEMODE odreduje hoce li se objekti skoSavati u produZetku.
Ako odaberemo izvodenje skoSenja zadavanjem dviju udaljenosti (Distance), potrebno je:

- definirati prvu udaljenost skoSenja (npr.1 mm)

CHAMFER Specify first chamfer distance <0.0000>: 1

- definirati drugu udaljenost skoSenja (npr. 1 mm)

CHAMFER Specify second chamfer distance <1.0000>: 1

- odabrati prvu liniju koja ¢e biti skoSena

CHAMFER Select first line or [Undo Polyline Distance Angle Trim mEthod Multiple]:

- odabrati drugu liniju koja ¢e biti skoSena

CHAMFER Select second line or Shift-select to applay corner or [Distance Angle
Method]:

Ako odaberemo izvodenje skoSenja zadavanjem udaljenosti i kuta (Angle), npr. 45°, potrebno
je:
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- definirati duljinu skoSenja prve linije (npr. 1 mm)

CHAMFER Specify chamfer lenght on the first line <0.0000>: 1

- definirati kut skosenja (npr. 45°)

CHAMFER Specify chamfer angle from the first line <0>: 45

- 0dabrati prvu liniju koja ¢e biti skosena

CHAMFER Select first line or [Undo Polyline Distance Angle Trim mEthod Multiple]:

- odabrati drugu liniju koja ¢e biti skoSena

CHAMFER Select second line or Shift-select to apply corner or [Distance Angle
Method]:

5.12. IZVODENIJE ZAOBLJENJA

Naredba FILLET (Modify = Fillet ﬂ) omogucuje zaobljenja uglova objekata (slika 5.17).

10 &
| -
2 2
&
= :
| M |
40 & L 30 L
2 b

Slika 5.17. Zaobljenje objekata

Prvi korak prilikom zaobljenja objekata jest odabir opcije Radius:

FILLET Select first line or [Undo Polyline Radius Trim Multiple]:
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Sljedeci je korak definiranje polumjera zaobljenja:

FILLET Specify fillet radius <0.0000>: 5

Odabir prvog objekta koji ¢e biti zaobljen:

FILLET Select first object or [Undo Polyline Radius Trim Multiple]:

Odabir drugog objekta koji ¢e biti zaobljen:

FILLET Select second object or shift-select to apply corner or [Radius]:

Nakon pozivanja naredbe FILLET odabiremo opciju Radius kojom definiramo polumjer
zaobljenja.

Polyline — skoSavanje polilinije

Trim — odreduje zadrzavaju li se uglovi nakon skoSavanja
Multiple — visestruko skosavanje

5.13. RASTAVLJANJE OBJEKATA

Naredba BREAK (Modify = Break ™) omoguéuje rastavljanje dijelova linija, kruznica,
elipsa i spline krivulja.

Prvi je korak odabir objekata koje zelimo rastaviti. Mjesto odabira zapravo se shvaca kao prva
tocka rastavljanja:

BREAK Select object:

Sljedeci je korak odabir druge tocke rastavljanja:

BREAK Specify second break point or [First point]:

5.14. SPAJANJE OBJEKATA

Naredba JOIN (Modify = Join - ) omogucuje spajanje dijelova linija, kruznica, elipsa i
spline krivulja u cjelinu.

Prvi je korak odabir objekata koje zelimo spojiti:

Danijela Pezer, pred.



RACUNALOM PODRZANO OBLIKOVANJE

JOIN Select source object or multiple objects to join at once:

Odabir objekata koje spajamo u cjelinu potvrdujemo tipkom ENTER:

JOIN Select object to join: ENTER

5.15. RAZBIJANJE OBJEKATA

Naredba EXPLODE (Modify = Explode @) omogucuje razbijanje sloZenih objekata na
sastavne objekte.

Prvi je korak odabir objekata koje zelimo ,,razbiti* na sastavne dijelove:

EXPLODE Select object:

Odabir potvrdujemo tipkom ENTER:

EXPLODE Select object: ENTER

5.16. BRISANJE OBJEKATA

Naredba ERASE (Modify = Erase & ) omogucuje brisanje odabranih objekata.
Nakon pozivanja naredbe zahtijeva se oznacavanje objekata predvidenih za brisanje (Select
objects).

Objekti se mogu odabrati pojedinac¢no, klikom na Zeljeni objekt ili odabirom vise objekata
prozorom.

Odabir objekata prozorom mogu¢ je odabirom (lijevi klik misa) zdesna nalijevo ili slijeva
nadesno. Razlika je u tome §to ¢e odabirom objekata slijeva nadesno biti odabrani samo oni
objekti koji se cijeli nalaze unutar prozora za odabir (korisno kod sloZenih crteza), dok ¢e kod
odabira zdesna nalijevo biti ozna¢eni svi objekti koje prozor dotice.

Objekte je moguce brisati i naredbom DELETE. Zeljene objekte ozna¢imo, zatim unosom

naredbe DELETE ili pritiskom istoimene tipke na tipkovnici (Del) briSemo odabrane objekte.

5.17. SVOJSTVA OBJEKATA

Naredba PROPERTIES (Modify = Properties, desni klik na odabrani objekt ili Ctri+1)
omogucuje prikaz odnosno izmjenu svojstava objekata.
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5.18. SVOJSTVA PODUDARANJA (Match properties)

Naredba MATCHPROPERTIES (Modify - Match properties E?) omogucuje
prenosenje svojstava (npr. debljina i vrsta linija, veli¢ina slova, veli¢ina kotnih oznaka,
svojstva Srafure i sl.) s oznacenog objekta ¢ija svojstva zelimo prenijeti na druge objekte.

Nakon poziva naredbe MATCHPROP potrebno je odabrati bazni objekt, odnosno objekt s
kojeg zelimo preuzeti svojstva, zatim klikom na ostale objekte ta svojstva pridruzujemo.

AKO nam nije namjera preuzeti sva svojstva s nekog objekta (primjerice Zelimo preuzeti samo
boju nekog objekta, ali ne i razinu (layer), odabirom (desni klik miSa na objektu s kojeg
zelimo preuzeti svojstva) dijaloga Settings odabiremo svojstva koja Zelimo preuzeti (slika
5.18).

Basic Properties

= —
or
Layer Tanka
Linetype ByLayer Help
Linetype Scale 1
Lineweight ByLayer
Transparency ByLayer
Thickness 0

Plot Style

Special Properties

Dimension Text Hatch
Pahydine Viewport Table
Material Shadow display Muttileader

Slika 5.18. Odabir svojstava podudaranja
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6. ISPUNJAVANJE UZORKOM

6.1. HATCH

Naredba HATCH (Draw -> Hatch ) omogucuje ispunjavanje zatvorenih podrucja
uzorkom.

Pozivanjem naredbe HATCH otvara se dijalog za ispunjavanje uzorcima prikazan na slici 6.1.

FY P osee o B Pattem + [ - [Hatch Transparency D [ @
. % % NN A B x

E [l UseCurrent ~ Jangle

oL ANGLE ANSEL ANSE2 "B o - ak Set  Associative Annotative  Match Close

Pick Points .
E + Origin Properties” Hatch Creation

=

Boundaries + Pattern Properties ~ Origin ~ Options ~ ] Close
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et . — > < 8 Patem ~ & - |Hatch Transparency [0 - lﬁ X
B Remove / J . B W eyLayer 0

- |Ang\e e
Set Associative Annotative Match Close
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SOLD ANGLE ANSEL ANSE2 = B nNone ~ Hos % Origin Properties”  Hatch Editor
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Slika 6.1. Ispunjavanje uzorkom

Potrebno je odabrati podrucja koja Zelimo ispuniti uzorkom (Srafurom):

HATCH Pick internal point or [Select objects LUndo seTtings]:

Nakon §to smo odabrali podrucje koje Zelimo Srafirati, podeSavamo odgovarajuci uzorak (u
ovom slu¢aju ANSI31). Razmak izmedu linija (,,gustoca‘) Srafure podeSava se opcijom scale.
Nakon svih postavljenih parametara izbor potvrdujemo tipkom ENTER.

HATCH ENTER
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6.2. HATCH EDIT

AutoCAD

Sve naknadne promjene vezane uz ispunjavanje uzorkom mogu se uredivati u dijaloSkom
okviru Hatch Edit pozivom istoimene naredbe (slika 6.2).

Gumb Preview omogucuje uvid u trenuta¢ne postavke ispunjavanja na odabranom objektu.

A Hatch Edi

Hatch |Gradient

Type and pattem

Type:
Pattem:
Color:

Swatch:

Angle and scale
Angle:
1] -

Double

Hatch origin
() Use cument origin

@ Specified orgin

Bottom left

Predefined -
ANSI31 -]

| O Bylayer ~|@ -

Scale:
05 -

Relztive to paper space

Click to set new origin

[ Default to boundary exterts

[ Store as default origin

Boundaries

Add: Pick points

Add: Select objects

B

Remove boundaries
Fj“ Recreate boundary

Display boundary objects

o |

Cptions

[ Anmotative

Associative

[ Separate hatches

Draw order:

[Do Mot Change 'l
Layer:

lTanka limija v]

Transparency:
[ByLayer v

o [

Inherit Properties

lslands
lsland detection
lzland dizplay style:

2

() Normal

Boundary retention
Retain boundaries

Chject type: Palyline

Boundary set

Current viewport Mew

Gap tolerance

Tolerance: units
Inhert options
@ Use cument origin

() Use source hatch origin

x

OK | [ Cancel | [ Hep
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U nastavku su dana pojasnjenja stavki dijaloga ispunjavanja
uzorkom.

Kartica Hatch

Type — predstavlja tip, odnosno vrstu uzorka
Pattern — popis svih dostupnih uzoraka

Color — odabir boje uzorka (preporuka By Layer — definirana razina
za ispunjavanje uzorkom, u vecini slucajeva Srafurom)

Swatch — aktivni uzorak

Custom Pattern — popis dostupnih korisnickih uzoraka

Angle — Kkut zakreta uzorka u odnosu na apscisu aktivnog
koordinatnog sustava (Prilikom odabira ANSI31 uzorka kojim se
koristimo za Srafuru preddefinirani kut je 0, medutim Srafura se
iscrtava pod nagibom od 45°. Ako uzmemo da je kut 90°, Srafura

¢e biti iscrtana pod 45°, ali u suprotnome smjeru.)

Scale — mjera uveéanja ili smanjenja kojom reguliramo ,,gusto¢u’
uzorka

Boundaries

Add: Pick points — zadavanje toCaka unutar podrucja ispunjavanja
(najcesce koristeno)

Add: Select objects — odabir objekata ispunjavanja

2NN

MOAOR L

©

[

SRPUW

Madeling »

Line
Ray
Construction Line

Multiline

Polyline
3D Paolyline
Polygon
Rectangle
Helix

Arc »
Circle »
Donut

Spline b
Ellipse 2
Block 2

Table...
Point 2
Hatch...

Gradient...
Boundary...
Regicn
Wipeout

Revision Cloud

Text 4

Remove boundaries — uklanjanje odabranih objekata iz granice ispunjavanja uzorkom

Recreate boundary — redefiniranje granica

Display boundary objects — prikaz trenuta¢nih granica ispunjavanja u radnom prostoru

Inherit properties — preuzimanje svojstava ispunjavanja s postojeéeg ispunjenog objekta.
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PRIMJER ZA VJEZBU

Prema zadanom primjeru (slika 6.3) nacrtati remenicu, uz aktivan niSan tangent, te
primijeniti prethodno pojasnjene naredbe (COPY, MOVE, MIRROR, TRIM, JOIN,
OFFSET, ROTATE, HATCH) kako bi se postigao konac¢an izgled objekta.
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Slika 6.3. Priprema za crtanje pojednostavljene Konacan izgled

remenice

Remenica — pojednostavljeno TRIM, JOIN OFFSET
0 i
\ij

:Ih ‘t}]

ROTATE TRIM HATCH

Danijela Pezer, pred. o



RACUNALOM PODRZANO OBLIKOVANJE

7. KOTIRANJE

Naredbe za kotiranje nalaze se u padaju¢em izborniku Dimension, odnosno u istoimenoj
alatnoj traci (slika 7.1).

Prilikom otvaranja svakog novog AutoCAD-ova dokumenta, uz definiranje razina, potrebno
je definirati kotni stil (slika 7.1) te kotirati odabrane objekte naredbama za kotiranje.

Naredba DIMSTYLE (Dimension = Dimension style = ) omogucuje promjenu kotnog
stila.

4 7 80D O A HIE o 0 b A 14 & H IR
Dimension |

A Dimension Soie Ui

r?'l Quick Dimension Cument dimension style: 150-25
Styles: Preview of: |50-25
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(7 ArcLength
L] . ]
Crdinate Overide...
[ Compare...
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Jo 99 ed List: Description
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Close | | Help
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Continue
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Slika 7.1. Definiranje kotnog stila
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Pozivanjem naredbe DIMSTYLE otvara se dijalog Dimension Style Manager.

Prema slici 7.1.a) odabrani kotni stil je 1ISO-25. Moguce su izmjene postojecega kotnog stila
odabirom opcije Modify (slika 7.1.a)). Takoder je omoguceno Stvaranje novoga kotnog stila
odabirom opcije New te privremena promjena kotnog stila (Override).

Prva kartica Lines, medu ostalim, omogucuje namjeStanje udaljenosti kota od objekta (Offset
from origin — slika 7.1.b). Odabirom nule (0) definiramo da ne postoji razmak izmedu radnog
komada (objekta) 1 pripadajuce kote, ve¢ kota izlazi iz vrha radnog komada.

Kartica Simbols and Arrows omogucuje namjestanje veli¢ine kotnih strelica (slika 7.2.a), dok
kartica Text omogucuje namjestanje visine teksta (brojeva) (slika 7.2.b)).

Maodify Dimension Sty ]
Lines | Symbols and Amows | Text Fit Primary Units | Atemate Units | Tolerances
Amowheads
First:
[ # Closedfilld -
Second
[ # Closedfilid -
Leader:
[ # Closedfilld -
Amow size:
F] =
= Arc length symbal
Certer marks @) Preceding dimension text
N Above dmension text
one
& Mark 25 = None
Line Radius jog dmension
J le:
Dimension Break egange %0
EBreak size: Linear jog dimension
3.75 = Jog height factor:
15 2~ Test height
[ ok | [ cameel | [ Hep
a)
Modify Dimension Styl
Lines | Symbols and Amows | Tesxt Fit Primary Units | Atemate Units | Tolerances
Text appearance
Text style: |Standard - |[|
Text color: [ ByBlock -
Text height: g z
Fraction height scale: 1
Draw frame around text
Text placement Text alignment
Vertical: ‘ Above n | Horizortal
Horizontal: ‘ Certered - |
@ Aligned with dimension line
View Direction: ‘ Left to-Right v|
Offset from dim line: 0.625 = 150 standard
[ ok ] [ cameel | [ Hep

Slika 7.2. Definiranje veli¢ine kotnih strelica i visine teksta
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Kartica Fit, medu ostalim, omogucuje promjenu mjerne veli¢ine svih kota (veli¢ina teksta i
veli¢ina strelica) u radnom prostoru promjenom vrijednosti opcije Use overall scale of (slika
7.3.2)).

Nakon unesenih izmjena odabirom opcije Set Current primjenjujemo novoodabrana svojstva
na sve objekte u radnom prostoru (slika 7.3.b)).

Maodify Dimension Style [

Lines | Symbols and Amows | Text Fit Primary Units | Atemate Units | Tolerances
Fit options

¥ there isnt enough room to place bath text and
amows inside extension lines, the first thing to
move outside the extension lines is:

@) Etthertext or amows (best fit)
ATows
Text
Both text and amows

Always keep text between et lines

Scale for dimension features

Annotative

Suppress amows if they dont fit inside
extension lines
Scale dimensions to layout

Text placement
@ Use overall scale of: 1 =
When text is not in the default position, place it:
@ Beside the dimension line Fine tuning
COwer dimension line, with leader Place text manually
Ower dimension line, without leader 7| Draw dim line between ext lines
[ ok | | cCancel | [ Heb
a)
Cumert dimension style: [50-25
Styles: Preview of: |50-25
A Annotative ] Set Cument
150-25
| New... |
[ Modfy.. |
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| Compare... |
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Slika 7.3. Promjena mjerne veli¢ine svih kota u radnom prostoru
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7.1. DIJELOVI KOTE

Kota predstavlja blok sastavljen iz vise dijelova, kako prikazuje slika 7.4.

A

C B
/ 50

Slika 7.4. Dijelovi kote

A — tekst kote (Dimension Text)

B — mjerna crta (Dimension Line)

C — zavrsetak kote (Arrowhead)

D — pomo¢na mjerna crta (Extension Line)

7.2. VRSTE KOTA

Vrste kota podrzane programom AutoCAD prikazane su na slici 7.5.

’7 horizontal linear
100

diameter — r radius

b |

C

T aligned

110
®

40

N— angular

vertical linear ‘

40 &0 &0 a0
\— continued 4

Slika 7.5. Vrste kota u AutoCAD-u

baseline
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7.3. LINEARNE KOTE
Izvedba linearnih kota moguca je kao horizontalna (horizontal) i vertikalna (vertical).

Naredba DIMLINEAR (Dimension = Linear [~1) omoguéuje horizontalno i vertikalno
kotiranje.

Potrebno je definirati prvu tocku na odabranom objektu koja ¢e biti polaziste kote:

DIMLINEAR Specify first extension line origin or <select object>:

Sljedeci je korak definiranje druge tocke koja oznacava zavrSetak kote. Klikom (lijevi) misa
potvrdujemo odabrano:

DIMLINEAR Specify second extension line origin:

AKo zelimo izmijeniti kotni tekst ili zakrenuti kotu pod nekim kutom prije potvrde klikom
misa, odabiremo jednu od ponudenih opcija:

DIMLINEAR [Mtext Text Angle Horizontal \Vertical Rotated]:

Pojasnjenja ponudenih opcija:

Horizontal — odredivanje horizontalnog kotiranja — slika 7.6.a)

Vertical — odredivanje vertikalnog kotiranja — slika 7.6.b)

Mtext — oblikovanje kotnog teksta (naredba MTEXT) — slika 7.6.c)
Text — izmjena teksta (novi unos) — slika 7.6.d)

Angle — zakretanje kotnog teksta — slika 7.6.e)

Rotated — zakretanje linearne kote — slika 7.6.f) (kota zakrenuta za 20°)

50 @30
ip]
[N ]
a) b) c)
495 6@
A 92
d) e) f)

Slika 7.6. Izvedba linearnih kota
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7.4. KOTIRANJE OD ZAJEDNICKE OSNOVE

Naredba DIMBASELINE (Dimension = Baseline ) omoguéuje kotiranje od zajednicke
osnove (slika 7.7).

Prema primjeru (slika 7.7), najprije je kotirana dimenzija iznosa 30 mm koriStenjem naredbe
DIMLINEAR, zatim je pozivom naredbe DIMBASELINE nastavljeno kotiranje (preostalih
dimenzija — 50, 60 i 70 mm) od zajednicke osnove.

DIMBASELINE Specify second extension line origin or [Select Undo] <Select>:

Naredba zavrSava tipkom ESC.

30

o0
60

/0

Slika 7.7. Kotiranje od zajednicke osnove

7.5. ULANCANO KOTIRANIJE

Naredba DIMCONTINUE (Dimension = Continue 1) omogucuje ulancano kotiranje
(slika 7.8).

Prema primjeru (slika 7.8), najprije je kotirana dimenzija iznosa 30 mm koriStenjem naredbe
DIMLINEAR, zatim je pozivom naredbe DIMCONTINUE nastavljeno ulancano kotiranje
preostalih dimenzija — 20, 10 i 10 mm.

DIMCONTINUE Specify second extension line origin or [Select LUndo] <Select>:

Naredba zavrSava tipkom ESC.
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30 20 10, 10

Slika 7.8. Ulanc¢ano kotiranje

7.6. PORAVNANE KOTE

Naredba DIMALIGNED (Dimension > Aligned “+) omogucéuje kotiranje u ravnini s
objektom (slika 7.9).

Odabir prve krajnje to¢ke objekta kotiranja:

DIMALIGNED Specify first extension line origin or <select object>:

Odabir druge krajnje tocke objekta kotiranja:

DIMALIGNED Specify second extension line origin:

Naredbe Mtext Text Angle analogne su naredbi DIMLINEAR.

DIMALIGNED [Mtext Text Angle]:

Slika 7.9. Poravnane kote

Danijela Pezer, pred.
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7.7. KOTIRANJE POLUMJERA

Naredba DIMRADIUS (Dimension > Radius ©) omogudéuje kotiranje polumjera kruZnice
ili luka (slika 7.10).

Odabir kruznog luka ili kruznice:

DIMRADIUS Select arc or circle:

Pomicanjem pokazivaca odreden je polozaj kote i kotnog teksta:

DIMRADIUS Specify dimension line location or [Vitext Text Angle]:

7.8. KOTIRANJE PROMJERA

Naredba DIMDIAMETER (Dimension - Diameter ®) omogucuje Kkotiranje promjera
kruznice ili luka (slika 7.10).

Odabir kruznog luka ili kruznice:

DIMDIAMETER Select arc or circle:

Pomicanjem pokazivaca odreden je poloZaj kote i1 kotnog teksta:

DIMDIAMETER Specify dimension line location or [IVitext Text Angle]:

60

40

Slika 7.10. Kotiranje polumjera i promjera
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7.9. KOTIRANJE KRUZNOG LUKA

Naredba DIMARC (Dimension = Arc Length ) omoguéuje kotiranje kruznog luka (slika
7.11).

Odabir kruznog luka ili segmenta luka polilinije:

DIMARC Select arc or polyline arc segment:

Pomicanjem pokazivaca odreden je polozaj kote 1 kotnog teksta kruznog luka:

DIMDIAMETER Specify arc length dimension location, or [[Vitext Text Angle Partial]:

q%M

ﬁ\

e

Slika 7.11. Kotiranje kruznog luka

7.10. KOTIRANJE KOORDINATA

Naredba DIMORDINATE (Dimension = Ordinate &) omoguéuje kotiranje koordinata
(X, Y) zadanih toc¢aka prema aktivnom koordinatnom sustavu (slika 7.12).

U pravilu, potrebno je postaviti novi koordinatni sustav (UCS) u zeljenu tocku ishodista ili
objekte koje zelimo kotirati pozicionirati u ishodiste aktivnog UCS-a.

Ishodiste aktivnog UCS-a u Auto CAD-u

Prilikom kotiranja koordinata potrebno je uklju¢iti ORTHO mod.

Potrebno je zadati polaznu tocku kotiranja koordinata:
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DIMORDINATE Specify feature location:

odnosno krajnju tocku pokazivaca (leader):

DIMORDINATE Specify leader endpoint or [Xdatum Ydatum Mtext Angle]:

100

130 @
N
52

/3 Q

9 Y]

D
ol Al i co

150

Slika 7.12. Kotiranje koordinata

7.11. POKAZIVAC

Upotrebljava se pri oznacavanju pozicija, presjeka, znakova povrSinske obrade i dr. (slika
7.13).
Naredbe koje se rabe za postavljanje pokazivaca jesu MLEADER, QLEADER i LEADER.

Sve navedene naredbe u konacnici imaju istu svrhu, postavljanje pokazivaca, a razlikuju se po
stupnju slozenosti.

Kako i samo ime (Multileader) nalaze, mozemo zakljuciti da najvise moguénosti nudi naredba
MLEADER.

7.11.1. MLEADER (Multi Leader)

Naredba MLEADER (Dimension = Multileader /o ) omogucuje postavljanje pokazivaca
s tekstom.

Naredba MLEADER zapravo nije jedna naredba, ve¢ se sastoji od nekoliko naredaba kojima
se pristupa preko Multileader alatne trake, a koje omogucuju:
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e dodavanje ili uklanjanje dodatnih strelica pokazivaca na postojecem o0bjektu
pokazivaca

e uredno poravnhavanje pokazivaca

f® jﬁf;,,—@ /@
/_@ ?5/ &

—® 0

/

e prikupljanje viSestrukih pokazivaca u jedan pokazivac

=/

Naredba MLEADER pamti posljednji upotrijebljeni slijed, te prilikom ponovnog koristenja
naredbe taj slijed nudi kao zadani.

MLEADER Specify first corner of text or [leader arrowHead first leader Landing first
Options] <Options> :

Ako je odabrana opcija odredivanja pocetne toCke strelice pokazivaca (leader arrowHead
first), MLEADER izvr$ava naredbu na isti nacin kao i naredbe LEADER i QLEADER.

7.11.2. LEADER

Naredba L EADER omogucuje postavljanje pokazivaca s tekstom.

Odredivanje pocetne tocke strelice pokazivaca:

LEADER Specify leader start point:

Odredivanje druge tocke strelice pokazivaca:
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LEADER Specify next point :

Tipkom ENTER definiramo zavrSetak strelice pokazivaca:

LEADER Specify next point or [Annotation Format Undo] <Annotation>: ENTER

AKo ne zelimo automatski predvideno mjesto za ispis teksta uz pokaziva¢, ponovno
potvrdujemo tipkom ENTER:

LEADER Enter first line of annotation text or <options>: ENTER

Umjesto predvidenog mjesta za ispis teksta odabiremo opciju None ¢ime naredba zavrSava:

LEADER Enter an annotation option [Tolerance Copy Block None Mtext] <Mtext>:
None

Tekst je moguce upisati i pozicionirati prema zelji odabirom naredbe za oblikovanje teksta
DTEXT.

7.11.3. QLEADER (Quick Leader)

Naredba QLEADER takoder omogucuje postavljanje pokazivaca s tekstom.

QLEADER identi¢no izvodi naredbu za kreiranje pokazivaca kao i naredba LEADER, s
jedinom razlikom, a to je Sto su razli¢ite opcije oblikovanja dostupne i u dijaloskom okviru
(odabirom opcije Settings pritiskom tipke ENTER umjesto odabira pocetne to¢ke pokazivaca)
umjesto kao zapis naredbe u komandnoj liniji.

Odredivanje pocetne tocke strelice pokazivaca (identi¢no naredbi LEADER) ili odabir opcije
Settings koja otvara dijaloski okvir s trima karticama:

QLEADER Specify first leader point or [Settings] <Settings> :

Odredivanje druge tocke, odnosno mjesto zavrsetka strelice pokazivaca:

QLEADER Specify next point :

Tipkom ESC zavrsavamo naredbu.
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100

150

Slika 7.13. Pokazivac

7.12. GEOMETRIJISKE TOLERANCHE

Naredba TOLERANCE (Dimension = Tolerance &) omoguéuje postavljanje
geometrijskih tolerancija (slika 7.14). Upotrebljava se u kombinaciji s pokaziva¢em — naredba
QLEADER.

Sym Tolerance 1 Tolerance 2 Datum 1 Datum 2 Datum 3

BE B @ N i i i i
B B H B i i i i

Height: 0.01 Projected Tolerance Zone: E

Datum Identifier: |

| ok || cCancel |[ Hep |

Slika 7.14. Definiranje geometrijskih tolerancija

7.13. OZNACAVANIJE SREDISTA (CENTERMARK)

Naredba DIMCENTER (Dimension = Center Mark ®) omogucuje oznacavanje sredista
luka ili kruznice (+).
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Oznacavanje srediSta luka ili kruZnice moguce je izvrsiti odabirom zeljenog luka ili kruznice:

DIMCENTER Select arc or circle:

100

150

Slika 7.15. Oznacavanje sredista luka ili kruznice

7.14. DIMSCALE

Naredba DIMSCALE omogucuje promjenu kotnog stila, odnosno promjenu veli¢ine kotnih
strelica i visine teksta.

Zadana (defaultna) vrijednost je 1 (jedan), medutim ako promijenimo vrijednost na npr. 2,
veli¢ina svih naknadno kotiranih dimenzija (veli¢ina teksta i kotnih strelica) bit ¢e dvostruko
uvecana.

DIMSCALE Enter a new value for DIMSCALE <1.0000>: 2

7.15. DIMLFAC

Naredba DIMLFAC omogucuje promjenu veli¢ine dimenzija crteza.

Zadana (defaultna) vrijednost je 1 (jedan), medutim ako promijenimo vrijednost na npr. 0.5,
sve ¢e dimenzije biti smanjene u pola (npr. kota koja je mjerenjem iznosila 100 mm, nakon
unosa nove vrijednosti za DIMLFAC u iznosu 0.5, ponovnim kotiranjem iznosit ¢e 50 mm).

DIMLFAC Enter a new value for DIMLFAC <1.0000>: 0.5
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7.16. QUICKCALCULATOR

Prilikom crtanja u AutoCAD-u Cesto se javlja potreba za izraunavanjem izmjera na crtezu,
Sto dodatno olaksava moguénost koriStenja brzog kalkulatora pozivanjem naredbe
QUICKCALCULATOR. Brzi kalkulator prikazan je na slici 7.16.

1]

Basic Calculator Mode

Slika 7.16. Brzi kalkulator
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8. KREIRANJE BLOKOVA

8.1. BLOK

Naredba BLOCK (Draw = Block > Make &)

omogucuje kreiranje blokova.

Pozivom naredbe BLOCK otvara se dijalog Block
Definition u kojem je omoguceno kreiranje novog bloka
(slika 8.1). U ovom slucaju kao primjer kreiranja bloka

uzet je znak za oznacavanje postupka obrade v .

Unutar dijaloga potrebno je:

Dvoklikom na kreirani blok otvara se dijalog Edit Block
Definition (slika 8.2) koji
oblikovanje bloka.

Kreirani blok moguée je umetati (Insert = Block, =)
samo u *.dwg datoteku u kojoj je blok i kreiran!
Pozivanje (umetanje) bloka nije moguce u novoj
datoteci, ali je moguée njegovo kopiranje iz jedne u

definirati naziv (ime) bloka (Name)

odabrati (Pick point) hvatiste (Base point) koje
predstavlja tocku umetanja bloka

odabrati objekte koji ¢e Ciniti blok (Select
objects)

dodati opis bloka (Description)

potvrditi na gumb OK.

omoguc¢uje naknadno

drugu datoteku.

Modeling 3

Line
Ray

Construction Line

AN

Multiline

Polyline
3D Polyline
Polygon
Rectangle
Helix

MOOE L

Arc 3
Circle »

Donut

©

Spline 3
Ellipse »
Block 3

Table...
Point »
Hatch...

i

Gradient...
Boundary...
Region
Wipeout

Revision Cloud

SRPTE &

Text 3

L Make...

O Base

Ty Define Attributes...

MName:
znak obrade -
Base point Objects Behavior
Specify On-screen Specify On-screen [ Annatative
Fick point . Select objects - Match block orientation
to layout
X 246.3405246873165 ~) Retain [] Scale uniformly
. - - @ Convert to block
Y- 187.4335480073634 : [¥] Allow exploding
o ) Delete
’ 4 ohjects selected
Settings Description
Block unit: Znak obrade -
[ Milimeters -
[ Hyperink... ] i
[7] Open in block editor l oK l [ Cancel l [ Help

Slika 8.1. Kreiranje blokova
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Nakon kreiranja bloka prema prethodno opisanom postupku (pozivanjem naredbe BLOCK)

dvoklikom na blok otvara nam se dijalog Edit Block Definition koji omoguc¢uje oblikovanje
kreiranog bloka (slika 8.2).

Block to create or edit

Preview

<Cumrent D1E|w1'ni:=-

Description
Znak obrade

[ ok || Cancel |[ Hep |

Slika 8.2. Oblikovanje kreiranog bloka

Na listi kreiranih blokova potrebno je odabrati blok koji Zelimo uredivati. Potvrdom na dugme
OK otvara nam se Block Editor (slika 8.3) koji omogucuje uredivanje.

Featured Apps  BIM360  Performance | Block Editor . I

" Delete =
Jx
Construction . , .

- Parameters Authoring Point  Move Attribute
straint Status Manager  Palettes - - Definition

Manage Fl Action Parameters « Visibility

GOMRAA -/~

Alignment

=i Flip

b 2

E Visibility
-

E Lookup

Slika 8.3. Uredivanje kreiranog bloka
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8.2. PAMETNI BLOK

Naredba ATTDEF (Draw - Block = Define Attributes) omogucuje kreiranje takozvanih
pametnih blokova.

Pozivanjem naredbe ATTDEF otvara se dijalog Attribute Definition (slika 8.4) u kojem na
mjestu predvidenom za oznacavanje (Tag) unosimo oznaku atributa (u ovom slucaju slovo A)
1 smjeStamo ga na Zeljeno mjesto na kreiranom bloku. Za svaki novi atribut naredbu je
potrebno ponovno pozvati (razmaknica na tipkovnici takoder ponavlja posljednju naredbu).

Maode Attribute
[ Invisible Tag: A
Constant
- - Prompt:
[T] Verify
[ Preset Default: @
Lock position
[] Multiple lines Tesdt Settings
Justification: [ Left = ]
Insertion Paoirt
Specify Tet style: [Standard ,]
On-SCreen
g [] Annotative
s L Text height: 3 y
v.o (D U
Rotation: 1]
= |0
Boundary width: 0
Align below previous attibute definition
[ OK ] [ Cancel ] [ Help

Slika 8.4. Kreiranje atributa bloka

Nakon $to su definirani svi atributi bloka prikazani na slici 8.5 (u ovom slucaju A, B, C, D i
E), izlazi se iz editora bloka (Close Block Editor), nakon ¢ega slijedi prihvacanje spremanja
promjena za kreirani blok.

U slucaju umetanja novokreiranog bloka na crtez dijalog Edit Block Definition imao bi izgled
kao $to je prikazano na slici 8.6.
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Home Insert  Annotate  Parametric

Parameters Au
aint Status Manager  Palettes

Dimensional ] Manage

A oe @ H A [ H (R % RO R

Slika 8.5. Uredivanje blokova (Block Editor)

Block to create ar edit

Preview

<Cumrent meinib

Description
Znak obrade -

[0k J[ Camcel |[ Hep

Slika 8.6. Lista kreiranih blokova prilikom umetanja na crtez

Pozivanjem naredbe BATTMAN (u opciji kreiranja bloka Insert = Manage Attributes)
otvara se dijalog Block Attribute Manager (slika 8.7).
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Select block Block: | znak obrade -

Tag Prompt Default Modes Move Up

A L

: L
; L
D L

: .
< | T | "

Found in drawing: 1 Found in madel space: 1

v | v | -

Slika 8.7. Upravljanje atributima bloka

Potrebno je odabrati gumb Sync nakon ¢ega se dvoklikom na kreirani blok otvara dijalog
Enhanced Attributes Editor koji omoguc¢uje unos odgovaraju¢ih informacija na mjestima
predvidenima atributima. Na slici 8.8 pod atributom A unesen je tekst ,,Ra 0,8, nakon ¢ega je
potrebna potvrda na gumb OK. Ovakav nacin kreiranja blokova naziva se pametnim blokom.

Block: znak obrade Select block E
Tag: A
Attribute |Tead Options | F‘roperties|
Tag Prompt Value Ja
L
E =
C
D -
Value: |Ra 0.8
| sppy | | 0K | | Cancel | | Hep

Slika 8.8. Unos informacija na mjestima predvidenima atributima

AKo blok razbijemo naredbom EXPLODE, atributi nam postaju vidljivi na crtezu (slika 8.9),
te je ponovno dvoklikom na jedan od atributa moguce unositi odgovarajuci tekst.
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Edit Attribute Definit |

] | Cancel | |

Slika 8.8. Editiranje odabranih atributa

8.3. WBLOCK (Write Block)

Pozivom naredbe WBLOCK otvara se dijalog Write Block kojim je omoguéeno

pohranjivanje kreiranog bloka (prethodno opisanom naredbom BLOCK) na disk racunala na
mjesto po izboru korisnika (slika 8.9).

A Wete Block
Source
Block:
Enttire: drawing
@ Objects
Base point Objects
E Picl poirt ? Select objects E
¥ 239.2023823616635 @ Retain
Y: 159.4323327426634 Conver to block
Delete from drawing
Z 0 i
= 1 object selected
Diestination
File name and path:
SAMASTAVA ALt CAD znak obrade dwe - D
Insert HI'Ii'tSZ | Millimeters - |
| ok || cancel || Hep |

Slika 8.9. Pohranjivanje kreiranog bloka

Potrebno je odabrati (Select objects) objekte koji ¢e Ciniti blok koji Zelimo spremiti te tocku
hvatista (Base point — Pick point) koja ¢e biti to¢ka umetanja bloka u crtez.

Blok je pohranjen (trajno) kao *.dwg datoteka, a tu je datoteku moguée pozivati i umetati iz
svake sljedec¢e novootvorene AutoCAD-ove datoteke (slika 8.10).
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AutoCAD

Name:  nak obrade - Browse.
Path:  EMMASTAVAMAUtoCADznak obrade.dwg
Locate using Geographic Data
Insertion point Scale Ruotation
Specify On-screen [] Specify On-screen [] Specify On-screen
=0 o Angle:
T o Block Unit
z z Unit:  Milimeters
Factor:
[] Uniform Scale e 1
| Explode [ ok || cancel | [ Heb

Slika 8.10. Umetanje blokova

Znakom obrade oznacava se hrapavost tehnickih povrsina na tehni¢kim crtezima.

Simboli hrapavosti prilikom obrade s odvajanjem cestica ili bez njihova odvajanja definirani
su normom ISO 1302-2001. Osnovni graficki simbol prikazan je na slici 8.11. Potrebno je
uskladiti oznake simbola s ostalim oznakama na tehnickom crtezu (kote, tolerancije itd.),
definirano prema ISO 81714-1. Dimenzije simbola prikazane su tabli¢no (tablica 8.1), a

vrijednosti su izrazene u mm.

dl‘

H>
y

s

)

Slika 8.11. Osnovni grafi¢ki simbol za oznacavanje hrapavosti tehni¢kih povrsina

Tablica 8.1. Izmjere oznaka osnovnog grafi¢kog simbola za oznacavanje hrapavosti tehnic¢kih povrsina

Visina brojki i slova, h (ISO 3098-2) 2,5
Debljina linije za slova d

35

7,5
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7 10
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14 20
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9. ISPIS

Ispis dokumenta nazivamo PRINT, a ispis u programu AutoCAD naziva se PLOT. Crtez
nacrtan programom AutoCAD moguce je isprintati, odnosno (is)plotati na pisacu (ploteru) ili
pomocu virtualnog pisaca koji sprema datoteku u PDF, JPG, PNG i sl. formatu.

Ispis je moguce izvrsiti ako je prireden crtez koji zelimo ispisati i ako je instaliran pisa¢
(ploter) ili virtualni pisa¢ (printer). Pisa¢ mora biti podignut u operativnom sustavu i
programu AutoCAD.

Podizanje i postavke pisaca moguce je odrediti:
e U operativnom sustavu (Start - Settings - Control Panel - Settings = Autodesk
Manager)
e U AutoCAD-u (File = Ploter Manager ili Tools = Options = Plot and Publish).

Ovisno o tome je li potreban zahtjevniji ili jednostavniji ispis, odabire se i naéin ispisa.
Ispisivanje je moguce iz karticce MODEL (jednostavniji ispis) ili LAYOUT (zahtjevniji
ispis).

U slucaju jednostavnijeg ispisa potrebno je:

e pozicionirati se u karticu MODEL
e pozvati naredbu PAGESETUP ili iz izbornika File > Page Setup Manager (slika

9.1)
ram
L
C tl t: Model
nﬁ urrent layou ode
Page setups
Current page setup: <MNone:=
Model* Set Current
New...
I Import... I
Selected page setup details
Device name: Microsoft Office Document Image Writer
Plotter: Microsoft Office Document Image Writer Driver
Flot size: 210,06 x 297.05 mm (Landscape)
Where: Microsoft Document Imaging Writer Port:
Description:
[7] pigplay when creating a new layout I Close J I Help

Slika 9.1. Upravljanje stranicom ispisa iz kartice Model

Danijela Pezer, pred.



RACUNALOM PODRZANO OBLIKOVANJE

e potrebno je kliknuti na gumb Modify (slika 9.1), nakon ¢ega se otvara dijalog prikazan
naslici 9.2.

Page Setup -

Page setup Flot style table (pen assignments)
r-
Marme: <Mone > :“ [monochrome.ctb v]
[ pisplay plot styles
Printer fplotter
MName: [@ Samsung M262x 282« Series v] [ Properties ] . )
Shaded viewport options
= Mone
Plotter: @ Samsung M262 282 Seres N 210 MM K Shade plat
. . & Microsoft XPS Documert Writer KE ? P s displaye
= & Foxit Reader PDF Printer - - —
_arrna -
Description: & Fax i .
B AutoCAD PDF (General Documentation).pe3
{B AutaCAD PDF (High Quality Frint) pc3 300
B AutoCAD PDF (Smallest File)pc3
B AutoCAD PDF (Web and Mobile) pc3
Faper size B Default Windows System Printer pc3 Flot options
B DWFE ePlot pc3 s
A4 8 DWFx ePlot (XPS Compatible) pc3 Plot object ineweights
'v' DWG To PDF pc3 || Plot transparency
B PublishToWeb JPGpc3 o
Plot area B PublishToWeb PNG pe3 Plot with plot styles
What to plot: Fit to paper Plot paperspace last
[Windnw v] l Window < ] Scle: [Custom Hide paperspace objects
Plot offset (origin set to printable area) 1 mm | = Drawing orientation
X 0,00 Center the |:I|Dt . @ Porfrait by
— = ) Landscape
| IERE Scale lineweights ] Plot upsidedown
(o) (om]) (]
Slika 9.2. Definiranje postavka ispisa iz kartice Model
Potrebno je:
o odabrati pisa¢ (npr. Samsung XX-xxxx ili opciju spremanja u *.pdf formatu ->
DWG to PDF)

o odabrati format papira (npr. A4)

o odabrati podrucje ispisa (Window) — u radnom prostoru odabrati Zeljene objekte za
ispis (ako je crtez smjeSten u okvir sa sastavnicom/zaglavljem, odabrati krajnje
tocke okvira (npr. donji lijevi 1 gornji desni ugao)

o smjestiti crtez u srediSte papira (Center the plot) — crtez je moguce i pomicati na
papiru po X i Y osi (opcija Plot offset)

o prilagoditi mjerilo papiru (odabrati opciju Fit to paper) ili definirati mjerilo
(odabrati opciju Scale i odgovarajuce mjerilo ispisa)

o odabrati CTB datoteku (monochrome.ctb) — datoteka s postavkama debljina linije

o odabrati polozaj papira (npr. Portrait)

o pregled crteza prije ispisa (Qumb Preview).

e Ako postavljeni parametri zadovoljavaju, ispis se potvrduje gumbom OK, nakon ¢ega

se crtez ispisuje na pisacu ili se zahtijeva mjesto spremanja datoteke ako je primjerice
odabran ispis u *.pdf formatu.
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U slucaju slozenijeg ispisa potrebno je:
e pozicioniranje u karticu LAYOUT
e pozivanje naredbe PAGESETUP ili iz izbornika File > Page Setup Manager (slika

9.3)

s v oo L =

| i |

‘ Current layout: Layoutl
DWE
Page setups

Current page setup: <Maone>

A ayoutl™® Set Current

Modify...

1fl

Import...

Selected page setup details

Device name: Mone

Plotter: Mone

Plot size: 210,00 % 297.00 mm (Portrait)

Where: Mot applicable

Description: The layout will not be plotted unless a new plotter

configuration name is selected.

[ Display when creating a new layout [ Close ] [ Help

Slika 9.3. Upravljanje stranicom ispisa iz kartice Layout

e kliknuti na gumb Modify, nakon ¢ega se otvara dijalog prikazan na slici 9.4.

Potrebno je:

o

©)
@)

(©]

o O O O

odabrati pisa¢ (npr. Samsung XX-xxxx ili opciju spremanja u *.pdf formatu ->
DWG to PDF)

odabrati format papira (npr. A4)

odabrati podrucje ispisa (Layout) — prilagoditi prozor pogleda, odnosno oznaciti
radni prostor vidljiv za ispis definiranjem novog prozora pomocu opcije View >
Viewports - 1Viewport

moguce pomicanje crteza na papiru po X i Y osi (opcija Plot offset) — ako je
sastavnica ve¢ nacrtana, obi¢no vrijednosti X i Y ostaju 0

odabrati mjerilo ispisa (opcija Scale)

odabrati CTB datoteku (monochrome.cth) — datoteka s postavkama debljina linije
odabrati poloZaj papira (npr. Portrait)

pregled crteza prije ispisa (gumb Preview).
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M Page Setup - Layoutl

B =

Page setup Plot style table {pen assignments)
-
£
Mame: <Mone = |:| [monud‘urome.cﬂ: v]
isplay plot styles
[ Display plot styl
Printer fplotter
Mame: =) Samsung M262e 282« Series 4 Properties
[@ ] [ ] Shaded viewport options
Plotter: Samsung M252x 282x Series - Windows SystemDric. 3 oyg MW k— = e e
Where: 123,198.34.65 x ) )
Y o
Description: ~
=
= 300
Paper size Flot options
Ad - Plot object ineweights
ot transparency
[T Plot tr
Plot area Plot scale Plat with plot styles
What to plot: Fit to paper Plot paperspace last
Seale: [1' 1 '] [T Hide paperspace obijects
Plot offset (origin set to printable area) 1 mm | = Drawing orientation
y. 0.00 mm Center the plot 9/ Portrait b
1 unit A
0.00 ") Landscape
W= ' mrn Scale lineweights
[ Scale ineweig [| Plot upside-down
Co]) (om] [

Slika 9.4. Definiranje postavka ispisa iz kartice Layout

e Ako postavljeni parametri zadovoljavaju, ispis se potvrduje gumbom OK, nakon Cega
se crtez ispisuje na pisacu ili se zahtijeva mjesto spremanja datoteke ako je primjerice

odabran ispis u *.pdf formatu.

AKoO je potreban ispis crteza sa sastavnicom (Sto je najeSée neizostavni dio u tehnickim

strukama), procedura ispisa nesto je sloZenija.

Sastavnicu je moguce umetnuti na vise nacina:
1) nacrtati sastavnicu u kartici MODEL te ju prilagoditi u pogledu LAYOUT
2) nacrtati sastavnicu direktno u LAYOUT-u i spremiti ju kao Template s ekstenzijom

*.dwt

3) izraditi sastavnicu kao WBLOCK te ju kao takvu upotrebljavati gotovu umetanjem

(insertiranjem) u LAYOUT.

U nastavku ¢e detaljnije biti pojaSnjeno crtanje okvira i sastavnice (zaglavlja) direktno u
LAYOUT-u te nacin pripreme crteza u OKviru sa sastavnicom.

Iz kartice MODEL potrebno je prije¢i u karticu LAYOUT (1 ili 2). MiSem se pozicionirati na
odabranu karticu i desnim klikom odabrati prethodno pojasnjenu opciju Page Setup Manager.
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Nacrtati okvir dimenzija A4 papira (210 x 297 mm), koji neée biti vidljiv prilikom ispisa, a
sluzi iskljucivo da se unutar njega definira vidljivi okvir pomaknut za 20 mm s lijeve strane i
5-6 mm sa svih ostalih strana (dimenzije vidljive na slici 9.5), zatim nacrtati zaglavlje
(sastavnicu).

Nacrtanu sastavnicu potrebno je spremiti kao Template u *.dwt formatu i imenovati
primjerice SASTAVNICA. Novonastali Template je sastavnica.dwt.

Prilikom crtanja novog crteza, sada kada postoji template sastavnica, moguce ju je otvoriti i
unutar kartice MODEL te crtati Zeljeni crtez. Kada se ponovno otvori LAYOUT, crteZ nije
vidljiv, stoga je potrebno otvoriti prozor pogleda unutar kojega ¢e biti smjesten crtez (S trake
padajuc¢ih izbornika odabrati View -> Viewports > 1 Viewport). Potrebno je odrediti
dimenzije gledista, odnosno prvu to¢ku (Specify corner of viewport or:), npr. donji lijevi
ugao, te drugu tocku (Specify opposite corner:), npr. gornji desni ugao.

Crtez je sada vidljiv na papiru, medutim, da bismo njime mogli manipulirati (smanjivati ga,
povecavati, pomicati), treba biti aktivan gumb MODEL u statusnoj traci (viewport je
podebljan). Unutar ukljué¢ene opcije PAPER Space crteZ nije moguée pomicati. Na slici 9.6
prikazani su primjeri izgleda gledista (viewporta) kada su uklju¢eni MODEL Space (slika
9.6.a)), odnosno PAPER Space (slika 9.6.b)).

Unutar opcije Page Setup Manager definirane su dimenzije papira (mjerilo papira), a
potrebno je prilagoditi mjerilo crteZa u odnosu na veli¢inu odabranog papira. Oznacavanjem
Viewporta i desnim klikom miSa otvara se padajuci izbornik (pri tome mora biti odabran
PAPER Space). Odabirom opcije Properties otvara se prozor u kojem je dostupan podatak
Custom scale (mjerilo ispisa) (prikazano na slici 9.7). U strojarstvu se izmjere definiraju u
milimetrima, stoga je pretpostavka da je crtez predviden za ispis u milimetrima, te ako pod
Custom scale unesemo vrijednost 1 (jedan), mijerilo ispisa zapravo ¢e biti M1:1, jer je
prethodno odabrana veli¢ina papira A4 s izmjerama u milimetrima.

Ispis Ce se izvrsiti za sve elemente koji se nalaze unutar crtkanog okviral!!!

U nastavku je dana tablica (tablica 9.1) propisanih mjerila.

Tablica 9.1. Propisana mjerila (ISO 5455)

Vrsta mjerila Propisano mjerilo

Uvecanje 50:1 20:1 10:1
5:1 2:1

1:2(1:2)5) 1:5 1:10
Umanjenje 1:20 1:50 1:100

1:200 1:500 1:1000

1:2000 1:5000 1:10 000

Mjerilo je potrebno definirati prije pocetka crtanja crteza kako bismo crtez prilagodili papiru
prije ispisa. Na osnovi mjerila podesavamo kotni stil (veli¢inu kotnog teksta i strelica).
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Tehnicki crtezi ispisuju se na propisanim (ISO 5457) formatima papira (normalni format,
produZeni i izuzetno produzeni format papira). Tablica 9.2 prikazuje propisane dimenzije
normalnih formata papira za ispis tehnickih crteza.

Tablica 9.2. Propisani (normalni) formati papira za ispis tehnickih crteza

Normalni format Dimenzije, mm

841 x 1189

Iz Ao formata papira proizlaze sve ostale veli¢ine formata A (A; do Ajg). Povrsina A formata
papira iznosi 1 m? Formati papira su standardizirani (ISO 216 standard) na na¢in da omjer

njihove §irine i duZine iznosi 1:v/2. Savijanjem papira na pola (po duZini) dolazimo do
sljedecega manjeg formata s istim omjerom stranica.
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Slika 9.5. Dimenzije A4 formata papira i okvira
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Viewport

tanka

SlLiL
\
g

= L] Z

2 provrio @32

Slika 9.7. Definiranje mjerila
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Na slici 9.9 prikazan je primjer Cesto koriStena zaglavlja tehnickih crteza s definiranim
izmjerama.

130
15 17 25
© Mierilo: Datum: Ime i prezime: SVEUCILISNI ODJELS 51? STRUCNE STUDIJE
00) Pozicija: Sklopni crtez: Materijal:
) Broj crteza: Naziv dyjela:
32 S8

Slika 9.9. Primjer zaglavlja

Slika 9.10 prikazuje primjer zaglavlja s definiranim izmjerama dostatan studentima za prikaz

crteza izradenih na vjeZbama iz podrucja AutoCAD u sklopu kolegija Tehni¢ko crtanje i
CAD.

MJERILO IME CRTEZA GRUPA =)
M1 IME | PREZIME DATUM S
25 120

185

Slika 9.10. Primjer zaglavlja za vjezbe
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10. OSNOVE CRTANJA U TRI DIMENZIJE (3D) U PROGRAMU
AutoCAD 2016

U nastavku su dane osnove crtanja u tri dimenzije (3D) uz prikaz i pojasnjenje osnovnih
naredaba te njihove primjene na jednostavnom primjeru (ortogonalno projiciranje).

10.1. DEFINIRANJE KORISNICKOG KOORDINATNOG SUSTAVA U
3D PROSTORU

Za razliku od 2D crtanja kod kojeg postoji jedna ravnina (XY), prilikom 3D crtanja koriste se
tri ravnine:

e XZ (ravnina nacrta)

e XY (ravninatlocrta) i

e YZ (ravnina bokocrta),

odnosno odabire se jedna ravnina za crtanje s moguc¢no$cu promjene pogleda na ostale
ravnine pod kutom od 90°.
Izgled korisnickog koordinatnog sustava UCS-a nije isti za 2D i 3D crtanje.

Promjena ikone UCS-a za rad u 3D moguca je preko padajuceg izbornika View - Display =
UCS icon - Properties, nakon ¢ega se otvara dijalog UCS lIcon u kojem je potrebno
odabrati 3D (UCS icon style) —slika 10.1.

A UCs Icon

LICS icon style Preview
20

@ 3D Line width: 1 vl

UCS icon size
R U

UCS icon color

Model space icon color: Layout tab icon color:

[ White v| |.Culor1ﬁﬂ' v|

| Apply single colar

| ok | | canced | [ Hep |

Slika 10.1. Definiranje ikone korisni¢koga (lokalnoga) koordinatnog sustava
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10.2. UVOD U 3D CRTANJE U AutoCAD-u

Nakon pokretanja AutoCAD-a potrebno je odabrati 3D mod za modeliranje. Na statusnoj traci
odabire se opcija (oznaceno kvacicom) 3D Modeling, kako prikazuje slika 10.2.

Drafting & Annotation
3D Basics
v 3D Modeling

Save Current As...
Workspace Settings...

Customize...

Display Workspace Label
8~ -+ | [ Decimal ~ E

Slika 10.2. Prijelaz u 3D mod AutoCAD-a

Prilikom crtanja u 3D vaznu ulogu ima alatna traka View = 3D Views... koja omogucuje
razne poglede na crtez u odredenoj projekciji:

Top — pogled odozgo (XY ravnina) predstavlja TLOCRT (T)

Bottom — pogled odozdo (XY ravnina) predstavlja gornji TLOCRT (T1)
Left — pogled slijeva (YZ ravnina) predstavlja desni BOKOCRT (B)
Right — pogled zdesna (YZ ravnina) predstavlja lijevi BOKOCRT (B1)
Front — pogled sprijeda (XZ ravnina) predstavlja NACRT (N)

Back — pogled straga (YZ ravnina) predstavlja straznji NACRT (N1)
SW ISOMETRIC — 3D pogled s jugozapada (South-West)

SE ISOMETRIC — 3D pogled s jugoistoka (South — East)

NE ISOMETRIC — 3D pogled sa sjeveroistoka (North- East)

NW ISOMETRIC — 3D pogled sa sjeverozapada (North- West).

Navedene opcije moguce je prona¢i u lijevom uglu radnog prostora (prostora za crtanje i
modeliranje) ispod kartice Start (slika 10.3). Moguce je prilagodivati i izgled modela (npr.
zicani, sjencani, puni, skica itd.), takoder prikazano na slici 10.3.
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Home 5olid

t T Polysal

a
. Presspt
Box Extrude M Fressp

Modeling =
Start

[—1I5E Isometric JJConceptual]

[-1ISE sometric ][Conceptuall [—1ISE Isometric J[Conceptuall

Custom Model Views 3 Custom Visual Styles b
Top 20 Wireframe
Bottom v Conceptual
et Hidden
Right -
< Realistic
Front
Shaded
Back )
SW Isometric Shaded with edges
v SEIsometric Shades of Gray
ME Isometric Sketchy
MW Isometric Wireframe
: K-ray
View Manager...
v Parallel Visual Styles Manager...
Perspective

Slika 10.3. Opcije pogleda na 3D model

Projekcija je prikaz trodimenzionalnog predmeta u ravnini, a za prikaz tehnickih crteza
primjenjuje se ortogonalno projiciranje koje omogucuje Sest (6) pogleda (prvih Sest prethodno
navedenih toc¢aka) prikazanih na slici 10.4.

Kod ortogonalne projekcije zrake projiciranja okomite su na ravninu crtanja, a predmet se
nalazi izmedu ravnine crtanja, odnosno projiciranja i crtaca. Crta se dio predmeta koji je
vidljiv u smjeru gledanja.

Kod ortogonalne projekcije paralelni i jednaki bridovi u prostoru ista svojstva zadrzavaju i u
projekciji. Takoder, kutovi koji su jednaki u prostoru, isti odnos zadrzavaju i u projekciji.
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TLOCRT 1
T1

pogled

odozdo

TLOCRT
T
pogled

odozgo

Slika 10.4. Europski nad¢in prikaza projekcija

Slika 10.5 prikazuje 3D koordinatni sustav UCS (User Coordinate System) i moguée opcije
za pozicioniranje aktivnog UCS-a.

+X
+Y koordinatna os X

ishodiste

Slika 10.5. Prikaz koordinatnog sustava (UCS) uz pripadajuce opcije

Origin — omogucuje pozicioniranje UCS-a u odredenu to¢ku
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Z - Axis Vector — omogucuje postavljanje UCS-a s moguénosc¢u odredivanja smjera Z-

0slI

3 Point — omogucuje definiranje nove pozicije koordinatnog sustava s pomocu triju
tocaka (0s X, Y i Z)

UCS, World — globalni koordinatni sustav postavljen u donji lijevi ugao radnog prostora

Ikonama I—» L. ° omoguceno je rotiranje koordinatnog sustava oko pojedine osi

X, Y ili 2).

Definiranje poloZaja koordinatnog sustava (UCS) odreduje korisnik.

Otvaranjem padajuceg izbornika Draw =» Modeling omoguéeno je modeliranje, odnosno
crtanje u tri ravnine 3D. Slika 10.6 prikazuje padajuci izbornik Modeling i pripadajuce

naredbe, koje ¢e biti pojasnjene u nastavku.

Draw Dimension Modify  Window Help
Modeling » | 1 Polysolid
/ Line D Box
/ Ray B Wedge
_/' Construction Line (05 |Gane
3. Multiline Q)| Sphere
D Cylinder
oot Polyline @ Torus
By 3D Polyline /S Pyramid
7 Polygen
1 Rectangle ;D (i
% Helix g Revolve
@ Sweep
Arc 3 @ Loft
© ;::ljt ’ f  Section Plane Extrude
Spline 3 Surfaces
Ellipse 4 Meshes w Loft
Block v Setup S
I
F] Table.. - Wedge " Revolve
Paint 3
Ef Hatch...
18 Gradient.. o Torus @ Sweep
u Boundary...
[Zy Region
g:"j Wipeout
E:} Revision Cloud
Text 3

Slika 10.6. Padaju¢i izbornik Modeling i pripadajuce naredbe

Polysolid — sluzi za transformiranje 2D linija (linija, polilinija, pravokutnik, kruznica, luk) u

3D oblike (tijela)
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Box — kreira 3D ¢vrsto tijelo (kocku, kvadar)
Baza ,kutije” crta se paralelno XY ravnini trenutacnog UCS-a (radna ravnina). Visinu
odreduje Z smjer koji moze biti pozitivan ili negativan, ovisno o postavljenom UCS-u.

Cylinder — kreira 3D ¢vrsto tijelo (valjak)
Valjak se kreira definiranjem centra kruznice, polumjera i visine valjka.

Cone — kreira 3D cvrsto tijelo (stozac) kruzne ili elipti¢ne baze koje se suzava prema vrhu.

Sphere — kreira 3D ¢vrsto tijelo (kugla)
Kugla je definirana zadavanjem sredista i polumjera.

Pyramid — kreira 3D ¢vrsto tijelo (piramida)
Piramida se definira zadavanjem centra baze, sredista stranice, dok treca tocka odreduje vrh
piramide.

Wedge — kreira 3D ¢vrsto tijelo (klin)
Smjer konusa uvijek je u pozitivnom smjeru X osi (aktivnog UCS-a).

Torus — kreira 3D &vrsto tijelo (vijenac — ,.krafna*)
Vijenac se kreira definiranjem centra, polumjera (ili promjera) unutarnje kruznice, zatim
definiranjem polumjera (ili promjera) vanjske kruznice vijenca.

Extrude — kreira 3D kruto tijelo ili povrSinu ekstrudiranjem (izdizanjem) 2D ili 3D krivulje.

Loft — kreira 3D ¢vrsto tijelo ili povrS$inu u prostoru izmedu nekoliko ravnina (nacrtani objekti
ne nalaze se u istoj ravnini!). Pri tome svi objekti moraju biti nacrtani s pomocu polilinije (ili
naredbom JOIN ili PEDIT (podopcija Join) spojiti u poliliniju).

Objekte je moguce spajati putanjama (path), sto je jedna od ponudenih opcija nakon poziva
naredbe LOFT.

Alatna traka Solid Editing (slika 10.7) sadrzZi sljede¢e naredbe koje se Cesto upotrebljavaju
prilikom 3D modeliranja:

Manage Output Add-ins  A360  Express Tools  Featured Apps  BIM 360

2 Slice ¢ Interfere "=

" & Thicken (7]) Extract Edges
rsect

- Fillet Edge  TaperFaces  Shell Section
@ Imprint @ Offset Edge - - - Plane

Primitive Solic Joolean Solid Editing Se El Selection

Slika 10.7. Alatna traka Solid

Union K& — sjedinjuje odabrane (dva ili vise) objekte (3D tijelo ili 2D lik)
Potrebno je odabrati istovrsne objekte za kombiniranje (sjedinjenje).

Subtract B4 — omogucuje izuzimanje (isijecanje) objekata (2D ili 3D)
Potrebno je odabrati objekte koje zelimo zadrzati, odnosno objekte od kojih izuzimamo —
odabir potvrdujemo tipkom ENTER. Potom slijedi odabir objekta koji izuzimamo (ENTER).

Intersect BB — kreira 3D ili 2D objekte od odabranih &vrstih tijela (3D) ili likova (2D) koji
se medusobno preklapaju.
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Slika 10.8 prikazuje alatnu traku Home s pripadaju¢im naredbama. Na toj se traci nalaze
naredbe iz izbornika Draw i Modify koje su istovjetne prethodno pojasnjenim naredbama kod
2D crtanja.

Home  Soli Surface Visualize  Parametric  Inse - te Vi Output  Add-ins

ﬁ ":{ & o Extract Edges = y B ) ‘@

Ll=e

B Presspull &€ ©@ x /e 3 O LR o R P X
Extrude
u 0 il Separate ~ i Plane [=- L. Unnamed ~

Modeling = Mesh  ~ Solid Editing = Viodify Section = 3 Coordinates Fl

BIM 3680  Performance

Group Base
Al u

View + Selection yers Groups *  View = u

Slika 10.8. Alatna traka Home s pripadaju¢im naredbama

10.3. PRIMJER 1ZRADE 3D MODELA S PRIKAZOM PROJEKCIJA

Na slici 10.9.a) prikazan je primjer 3D modela koji je kreiran u 3D modu programa
AutoCAD.

Dimenzije su dane kroz projekcije (nacrt, tlocrt i bokocrt — slika 10.9.b)) dobivene nakon
modeliranja, $to ¢e u nastavku biti prikazano te pojasnjeno i popraceno slikom.

<+

20

60

"

20

20

20

50

£

Slika 10.9. Primjer 3D modela s pripadaju¢im dimenzijama

S alatne trake Modeling pozivamo naredbu BOX koja omoguéuje kreiranje kvadra unutar
kojeg je potrebno nacrtati crtez u prostoru.

Definiranje prve tocke (ugla) kvadra (proizvoljna tocka u radnom prostoru):
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BOX Specify first corner or [Center]:

Definiranje drugog ugla kvadra ili definiranje duljine:

BOX Specify other corner or [Cube Lenght]: L

Odabrana je duljina L (lenght).

Sljedeci je korak definiranje duljine kvadra (npr. 50 mm):

BOX Specify length: 50

Definiranje $irine kvadra (npr. 50mm):

BOX Specify width: 50

Definiranje visine kvadra (npr. 60 mm):

BOX Specify height or [2Point]: 60

Za prethodno kreirani kvadar potrebno je postaviti UCS (koordinatni sustav) prema slici
10.10.

Slika 10.10. Postavljanje koordinatnog sustava

Potrebno je definirati prvu to¢ku kuta pravokutnika (slika 10.11.a)):

RECTANG Specify first corner point or [Chamfer Elevation Fillet Thickness \/idth]:
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Zatim je potrebno definirati drugu to¢ku kuta pravokutnika, u pravilu relativnim
koordinatama, ili zadati dimenzije (Dimensions) stranica:

RECTANG Specify other corner point or [Area Dimension Rotation]: D

Ako smo odabrali opciju definiranja dimenzija (D), sljede¢i je korak definiranje duljine
pravokutnika:

RECTANG Specify length for rectangles <10.0000>: 50

Zatim je potrebno definirati $irinu pravokutnika:

RECTANG Specify width for rectangles <10.0000>: 30

Zatim je potrebno definirati krajnju tocku pravokutnika (slika 10.11.b)):

RECTANG Specify other corner point or [Area Dimension Rotation]:

(>

Frielpresing:

a) b)

Slika 10.11. Definiranje tocaka pravokutnika (dijela koji ¢e biti ekstrudiran)

Sljedeci je korak odabir objekata za ekstrudiranje (slika 10.12.a)):

EXTRUDE Select objects to extrude or [VOde]:

Nakon odabira objekta odabir potvrditi tipkom ENTER.
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Sljedeci je korak definiranje visine pravokutnika ekstrudiranja:

EXTRUDE Specify height of extrusion or [Direction Path Taper angle Expression]
<20.0000> : -40

Izgled modela nakon ekstrudiranja prikazuje slika 10.12.b).

Slika 10.12. Prikaz koraka prilikom ekstrudiranja objekta

Sljedeci je korak izuzimanje prethodno ekstrudiranog objekta (drugog kvadra).
Potrebno je odabrati objekt koji Zelimo zadrzati (slika 10.13.a)):

SUBTRACT Select objects:

Nakon odabira objekta (slika 10.13.a)) odabir potvrditi tipkom ENTER.

Potrebno je odabrati objekt koji zelimo isjeci (slika 10.13.b)):

SUBTRACT Select objects:

Nakon odabira objekta (slika 10.13.b)) odabir potvrditi tipkom ENTER.

Izgled zicanog modela nakon izuzimanja prikazan je naslici 10.13.c).
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a) b) c)

Slika 10.13. Prikaz koraka prilikom izuzimanja objekta

Postavljanje UCS-a za nastavak modeliranja prikazano je na slici 10.14.

Slika 10.14. Postavljanje koordinatnog sustava
Slijedi definiranje pravokutnika (20 x 30 mm) koji ¢e se nakon ekstrudiranja takoder izuzeti
(isjeci) naredbom SUBTRACT.

Potrebno je definirati prvu to¢ku kuta pravokutnika (u odnosu na postavljeni UCS — slika
10.14):

RECTANG Specify first corner point or [Chamfer Elevation Fillet Thickness \Vidth]: -
10,0

Zatim je potrebno definirati drugu tocku kuta pravokutnika, u pravilu relativnim
koordinatama, ili zadati dimenzije (Dimensions) stranica:

RECTANG Specify other corner point or [Area Dimension Rotation]: -40,20
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Druga tocka pravokutnika definirana je relativnim koordinatama s vrijednostima -40, 20
prema aktivnom UCS-u (slika 10.14). Kreirani pravokutnik prikazan je na slici 10.15.

Slika 10.15. Izgled kreiranog pravokutnika

Potrebno je odabrati objekte za ekstrudiranje (pravokutnik — slika 10.16.a)):

EXTRUDE Select objects to extrude or [MOde]:

Nakon odabira objekta odabir potvrditi tipkom ENTER.

Sljedeci je korak definiranje visine pravokutnika ekstrudiranja:

EXTRUDE Specify height of extrusion or [Direction Path Taper angle Expression]
<20.0000> : -20

Izgled Zicanog modela nakon ekstrudiranja prikazuje slika 10.16.b).

< i

Slika 10.16. lzgled modela nakon ekstrudiranja
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Potrebno odabrati objekte koje zelimo zadrzati (slika 10.17.a)):

SUBTRACT Select objects:

Nakon odabira objekta (slika 10.17.a)) odabir potvrditi tipkom ENTER.

Potrebno odabrati objekte koje Zelimo isjeéi (slika 10.17.b)):

SUBTRACT Select objects:

Nakon odabira objekta (slika 10.17.b)) odabir potvrditi tipkom ENTER.

Izgled zicanog modela nakon izuzimanja prikazan je naslici 10.17.c).

a) b)

Slika 10.17. Prikaz koraka prilikom izuzimanja kvadra

Postavljanje UCS-a za nastavak modeliranja prikazano je naslici 10.18.

Danijela Pezer, pred.
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Slika 10.18. Polozaj aktivnog koordinatnog sustava za nastavak modeliranja

Potrebno je nacrtati kruznicu promjera 20 mm (slika 10.19):

- definiranjem sredista kruznice

CIRCLE Specify center point for circle or [3P 2P Ttr (tan tan radius)]:-25,15

- definiranjem polumjera (radijusa) kruznice

CIRCLE Specify radius of circle or [Diameter]: 10

Slika 10.19. Prikaz kreirane kruznice na trenuta¢nom modelu

Potrebno je odabrati objekt za ekstrudiranje (oznaciti kruznicu — slika 10.20.a)):

EXTRUDE Select objects to extrude or [MOde]:

Nakon odabira objekta objekt potvrditi tipkom ENTER.

Danijela Pezer, pred.



RACUNALOM PODRZANO OBLIKOVANJE

Sljedeci je korak definiranje visine valjka ekstrudiranja:

EXTRUDE Specify height of extrusion or [Direction Path Taper angle Expression]
<20.0000> : -20

Izgled Zicanog modela nakon ekstrudiranja prikazuje slika 10.20.b).

<

Slika 10.20. Prikaz koraka prilikom ekstrudiranja

Sljedeci je korak izuzimanje ekstrudiranog valjka.

Potrebno odabrati objekte koje Zelimo zadrzati (slika 10.20.a)):

SUBTRACT Select objects:

Nakon odabira objekta (slika 10.21.a)) objekt potvrditi tipkom ENTER.

Potrebno odabrati objekte koje Zelimo isjeci (slika 10.21.b)):

SUBTRACT Select objects:

Nakon odabira objekta (slika 10.21.b)) objekt potvrditi tipkom ENTER.

Izgled zicanog modela nakon izuzimanja prikazan je naslici 10.21.c).
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N7

a) b) c)

Slika 10.21. Prikaz koraka prilikom izuzimanja valjka

Konacan izgled modela prikazan je na slici 10.22.

//

\*}

b)

Slika 10.22. Konacan izgled modela

Nakon kreiranoga zeljenog 3D modela, ako zelimo prikaz projekcija (nacrt, tlocrt, bokocrt),
potrebno je prijeci u karticu Layout.

Opcija Base (slika 10.23) omoguc¢uje umetanje crteza iz prostora modela (Model Space) u
odabranoj kartici Layout.

Umetanje modela (hacrta) u kartici Layout prikazano je na slici 10.24. Nakon umetanja
desnim klikom misa odabiremo opciju eXit te uz pomicanje pokazivaca misa (dolje, desno,
lijevo...) rasporedujemo preostale projekcije i izometriju objekta (slika 10.25).

Crtez je moguce ispisati na papir prema koracima opisanima u poglavlju 9.
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l'[i-! From Model Space

lﬁ From Inventor

Slika 10.23. Opcija Base

Enter
Cancel

Recent Input 2

sElect
Orientation
Hidden lines
Scale
Visibility
Mowve
exit

&Y Pan

C':"q Zoom

@ SteeringWheels

QuickCalc

Slika 10.24. Umetanje modela (nacrta)
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Slika 10.25. Rasporedivanje projekcija

Slika 10.26 prikazuje opciju naknadnog definiranja mjerila (crveni trokuti¢) prethodno
rasporedenih projekcija kreiranog modela.

F—r————— 7 —

b———

===

Slika 10.26. Opcija naknadnog definiranja mjerila rasporedenih projekcija
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PRILOZI

Prilog 1. Standardni metri¢ki navoji ISO 68-1:1998, ISO 262:1998, 1SO 724:1993

Nazivna | Promjer | Korak | Radijus Promjer Promjer korijena Dubina navoja | Promjer

veli¢ina d=D p (n d, =D, vijka matice vijka | matice | provrta

ISO M korijena d; D, hs H, za navoj
1,00 1,00 0,25 0,036 0,838 0,693 0,729 0,153 0,135 0,75
1,10 1,10 0,25 0,036 0,938 0,793 0,829 0,153 0,135 0,85
1,20 1,20 0,25 0,036 1,038 0,893 0,929 0,153 0,135 0,95
1,40 1,40 0,30 0,043 1,205 1,032 1,075 0,184 0,162 1,10
1,60 1,60 0,35 0,051 1,373 1,171 1,221 0,215 0,189 1,25
1,80 1,80 0,35 0,051 1,573 1,371 1,421 0,215 0,198 1,45
2,00 2,00 0,40 0,058 1,740 1,509 1,567 0,245 0,217 1,60
2,20 2,20 0,45 0,065 1,908 1,648 1,713 0,276 0,244 1,75
2,50 2,50 0,45 0,065 2,208 1,948 2,013 0,276 0,244 2,05
3,00 3,00 0,50 0,072 2,675 2,387 2,459 0,307 0,271 2,50
3,50 3,50 0,60 0,087 3,110 2,764 2,850 0,368 0,325 2,90
4,00 4,00 0,70 0,101 3,545 3,141 3,242 0,429 0,379 3,30
4,50 4,50 0,75 0,108 4,013 3,580 3,688 0,460 0,406 3,80
5 5 0,80 0,115 4,480 4,019 4,134 0,491 0,433 4,20
6 6 1,00 0,144 5,350 4,773 4,917 0,613 0,541 5,00
7 7 1,00 0,144 6,350 5,773 5,917 0,613 0,541 6,00
8 8 1,25 0,180 7,188 6,466 6,647 0,767 0,677 6,80
9 9 1,25 0,180 8,188 7,466 7,647 0,767 0,677 7,80
10 10 1,50 0,217 9,026 8,160 8,376 0,920 0,812 8,50
11 11 1,50 0,217 10,026 9,160 9,376 0,920 0,812 9,50
12 12 1,75 0,253 10,863 9,853 10,106 1,074 0,947 10,20
14 14 2,00 0,289 12,701 11,546 11,835 1,227 1,083 12,00
16 16 2,00 0,289 14,701 13,546 13,835 1,227 1,083 14,00
18 18 2,50 0,361 16,376 14,933 15,394 1,534 1,353 15,50
20 20 2,50 0,361 18,376 16,933 17,294 1,534 1,353 17,50
22 22 2,50 0,361 20,376 18,933 19,294 1,534 1,353 19,50
24 24 3,00 0,433 22,051 20,319 20,752 1,840 1,624 21,00
27 27 3,00 0,433 25,051 23,319 23,752 1,840 1,624 24,00
30 30 3,50 0,505 27,727 25,706 26,211 2,147 1,894 26,50
33 33 3,50 0,505 30,727 28,706 29,211 2,147 1,894 29,50
36 36 4,00 0,577 33,402 31,093 31,670 2,454 2,165 32,00
39 39 4,00 0,577 36,402 34,093 34,670 2,454 2,165 35,00
42 42 4,50 0,650 39,077 36,479 37,129 2,760 2,436 37,50
45 45 4,50 0,650 42,077 39,479 40,129 2,760 2,436 40,50
48 48 5,00 0,722 44,752 41,866 42,857 3,067 2,706 43,00
52 52 5,00 0,722 48,752 45,866 46,587 3,067 2,706 47,00
56 56 5,50 0,794 52,428 49,252 50,046 3,374 2,977 50,50
60 60 5,50 0,794 56,428 53,252 54,046 3,374 2,977 54,50
64 64 6,00 0,866 60,103 56,639 57,505 3,681 3,248 58,00
68 68 6,00 0,866 64,103 60,639 61,505 3,681 3,248 62,00

r=0,1443-p; d,=d-0,6495p; d3=d-1,2269-p; D;=d-1,0,825-p; H=0,86603-p; hs=0,61343p
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Prilog 2. Tablica s vrijednostima konstante k za odredeni kut svrdla

Kut a Racunska konstanta Konstanta k
k .
(u praksi)

60° 0,8660254 0,866
82° 0,5751842 0,575
90° 0,5000000 0,5

118° 0,3004303 0,3

120° 0,3004303 0,289
135° 0,2071068 0,207

Dubina buSenja racuna se s obzirom na geometriju alata. Kako bismo dobili provrt zadane
duljine, potrebno je znati duljinu vrha svrdla. Duljina je odredena kutom vrha svrdla, a moze

se izraCunati prema izrazu:

NN

0D a
tg(90 — 7)
p = > XD

Budu¢i da se svrdla izraduju sa standardnim kutovima o, prethodno navedena formula moze
se pojednostavniti:

p =D xk,

pri ¢emu je K konstanta za odredeni kut o (najéesce koristeni kutovi dani su u gornjoj tablict).
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